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About this guide

This topic provides information about the contents of the Installation and User’s
Guide.

* |Chapter 1, “Overview,” on page 1| provides an overview of the master console.

» |Chapter 2, “Concepts,” on page 3|discusses concepts that will help you
understand how the master console works.

[Chapter 3, “Planning for the master console,” on page 7 describes how to plan
for the installation of the master console.

[Chapter 4, “Installing master console software,” on page 15 provides the
procedures required to install the master console, including how to use the
master console installation wizard.

[Chapter 5, “Configuring the master console,” on page 31| explains how to
configure the master console.

[Chapter 6, “Managing the master console,” on page 41| provides an overview of
the tasks that you can perform from the master console.

[Chapter 7, “Uninstalling master console software,” on page 49 provides a
high-level overview of the procedures for uninstalling the master console
software.

[Chapter 8, “Upgrading the master console to version 3.1,” on page 53| explains
when to upgrade the master console software.

[Chapter 9, “Troubleshooting the master console,” on page 57 provides
information about resolving problems with the master console.

The appendices provide the following additional information:
* Accessibility features of the master console and help system
* Notices

Who should use this guide

This topic describes the audience for the Installation and User’s Guide.

This guide should be used by the person or persons assigned to manage SAN File
System or SAN Volume Controller on a regular basis.

An administrator should have experience in at least the following skills, or have

access to personnel with experience in these skills:

¢ Microsoft Windows and Windows Advanced Server (depending on your client
environment)

¢ Linux system administration

* Networking and network management

* SAN management

¢ Command-line interface scripting

* Critical business issues (such as backup, disaster recovery, and security)

Notices

This topic describes the notice conventions used in the Information Center.
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The following notices are used in this Information Center and convey these specific
meanings:

Note: These notices provide important tips, guidance, or advice.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice appears before the instruction or situation in which damage
can occur.

CAUTION:

These notices indicate situations that can be potentially hazardous to you. A
caution notice appears before the description of a potentially hazardous
procedure step or situation.

DANGER

These notices indicate situations that can be potentially lethal or extremely
hazardous to you. A danger notice appears before a description of a
potentially lethal or extremely hazardous procedure step or situation.

Related Publications

vi

This topic describes the publications in the master console library and in related
libraries.

The following publication is available in the master console library. It is provided
in softcopy on the IBM® TotalStorage® Master Console Publications CD and at
fwww.ibm.com /storage/support} To use the CD, insert it in the CD-ROM drive. If
the CD does not launch automatically, follow the instructions on the CD label.

Note: The softcopy version of these publications are accessibility-enabled for the
IBM Home Page Reader.

 IBM TotalStorage Master Console for SAN File System and SAN Volume Controller
Installation and User’s Guidd, GC30-4090

This publication provides detailed procedures to set up and cable the hardware,
install and upgrade the master console software, configure the software
components, and troubleshoot and resolve problems.

These publications are related to SAN File System:
* IBM TotalStorage SAN File System Installation and Configuration Guide, GA27-4316

This publication provides detailed procedures to set up and cable the hardware,
install and upgrade the SAN File System software, perform the minimum
required configuration, and migrate existing data.

* IBM TotalStorage SAN File System Planning Guide, GA27-4344

This publication provides detailed procedures to plan the installation and
configuration of SAN File System.

* IBM TotalStorage SAN File System Maintenance and Problem Determination Guide,
GA27-4318
This publication provides instructions for adding and replacing hardware
components, monitoring and troubleshooting the system, and resolving
hardware and software problems.

These publications are related to SAN Volume Controller:
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http://www.ibm.com/storage/support/
fqg0_pdf.pdf

* IBM TotalStorage SAN Volume Controller: Installation Guide, SC26-7541

This guide includes the instructions the service representative uses to install the
SAN Volume Controller.

* IBM TotalStorage SAN Volume Controller: Planning Guide, GA22-1052

This guide introduces the SAN Volume Controller and lists the features you can
order. It also provides guidelines for planning the installation and configuration
of the SAN Volume Controller.

 IBM TotalStorage SAN Volume Controller: Service Guide, SC26-7542

This guide describes how to maintain the SAN Volume Controller. It also
includes a parts listing.

Web sites

This topic discusses any Web sites that offer additional, up-to-date information.

The following Web sites have additional and up-to-date information about SAN
File System:

* lwww.ibm.com /storage /support/sanfs/|

* [www.ibm.com/storage /software /virtualization /sfs|

The following Web site has additional and up-to-date information about SAN
Volume Controller:

* lwww.ibm.com /storage /support/2145/|

Summary of changes

This section describes the enhancements made to master console in release 3.1.

The following list describes the technical changes and enhancements made to
master console in release 3.1.

Installation enhancements
Installation enhancements for the master console in release 3.1 include:

¢ DS4000 Storage Manager Client (FAStT Storage Manager Client) and
IBM TotalStorage SAN Volume Controller Console are optional
components

¢ The master console information center is installed using the IBM
WebSphere® Help System and is installed as a service.

* The installation wizard checks your hardware for prerequisites before
installing the software.

* The installation wizard can be restarted if the installation is interrupted
or fails.

Upgrade enhancements
You can upgrade an existing software-only master console (releases 2.3 or
2.4) or an existing hardware master console (releases 1.3 or 1.4) using the
master console 3.1 installation wizard.

Note: In release 3.1, the product is referred to as master console.

About this guide vii
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Chapter 1. Overview

This topic provides an overview of the master console.

The master console provides a single point from which to manage IBM
TotalStorage products, such as the SAN File System and the SAN Volume
Controller.

The master console provides you with the following capabilities:

* Access to the metadata servers in the SAN File System cluster. You can access
these components:

— SAN File System console through a Web browser.
— Administrative command-line interface, through a Secure Shell (SSH) session.
— Any of the metadata server engines in the cluster through an SSH session.

— The RSA II adapter for any of the metadata server engines running SAN File
System software through a Web browser.

— Any of the SAN File System clients through an SSH session, a telnet session,
or a remote-display emulation package, such as Virtual Network Computing
(VNC), depending on the configuration of the client.

* Access to the SAN Volume Controller. You can access these components:
— SAN Volume Controller console through a Web browser.
— Administrative command-line interface, through a Secure Shell (SSH) session.

When using the master console with the SAN Volume Controller, you need to
install and configure it before configuring the SAN Volume Controller. The
installation and configuration steps are different between the hardware master
console and the software-only master console. For the hardware master console
(in which the software is preinstalled), you will need to customize the default
factory settings. The general steps for this are given in ['Hardware master]
[console configuration steps” on page 8|

* Access to the fibre channel switches and views of your SAN topology using
Tivoli® SAN Manager.

¢ Initiate a VPN connection, which allows an IBM support engineer to remotely
access the master console. You can monitor that access and disconnect the
session at any time. In addition, through the use of remote desktop access
software, such as VNC, the IBM support engineer can view the desktop of the
master console remotely.

* Manage SNMP traps through IBM Director, which can automatically notify IBM
support personnel in the event of a severe error and can submit e-mail
notifications to your personnel, such as a systems administrator.

A note on the two master console product options
Although you have two options in purchasing the master console product
(you can buy the master console software and install and configure it on
hardware of your choice, or you can buy a hardware platform with the
operating system and master console software preinstalled), the only
difference between these two options is the installation and configuration
process.

For the master console software option, the installation and configuration
is performed by you in a single process managed by the installation
wizard, as described in this guide.
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For the preinstalled option, with the software installed on the hardware in
the manufacturing plant using default settings, you will need to configure
and customize the settings as part of its installation process.
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Chapter 2. Concepts

This section discusses concepts that will help you understand how the master
console works. Becoming familiar with the master console components and
understanding the concepts in this section enables you to use the master console
most effectively.

Remote access

This topic provides an overview of the Remote Access feature and explains the
activities required to plan for it.

The master console provides remote access to the storage engines. Remote access
allows IBM Support Center personnel to diagnose problems with your system.
Remote access support can help to greatly reduce service costs and shorten repair
times, which in turn reduces the impact of any failures on your business.

Remote access gives IBM support personnel full access to the SAN File System or
the SAN Volume Controller through the master console, including querying and
controlling the metadata servers and clients, and accessing metadata, log, dump,
and configuration data. Remote access does not allow access without
authentication. You must initiate a secure Virtual Private Network (VPN)
connection from the master console to allow IBM support personnel to remotely
access the master console. From the master console, the support personnel can
establish a connection to the SAN File System metadata servers or SAN Volume
Controller nodes. However, you can monitor that access and disconnect the session
at any time.

In response to an error condition, you initiate a secure connection to the IBM VPN
server using the VPN connection software on the master console called IBM
Connection Manager. You must provide the customer connection ID for the newly
created connection to the IBM support personnel. The IBM support personnel
initiates a secure connection to their VPN server, and then establishes a secure
connection to the master console over the VPN tunnel using the customer
connection ID and a pre-authorized account on the master console. Finally, IBM
support personnel can access the SAN File System metadata server or SAN Volume
Controller node through SSH.

The following figure shows the remote access architecture:
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Figure 1. Remote access architecture

Service alert

This topic provides an overview of the service alert.

Service alert is a feature of the master console that enables SAN Volume Controller
to proactively notify the IBM Support Center of significant errors or failure
conditions. This enables IBM to respond quickly to problems that occur, sometimes
before the problem has been noticed by your system administrator. For SAN File
System, service alert notifies the system administrator of significant errors or
failure conditions.

SAN Volume Controller

In response to a sever error condition, SAN Volume Controller issues a Simple
Network Management Protocol (SNMP) trap and sends that trap to the IBM
Director Server running on the master console. The IBM Director Server catches the
trap and converts it into a Simple Mail Transfer Protocol (SMTP) e-mail message.
Two e-mail messages can be produced: one to the systems administrator in the
same way as in SAN File System, and another optional e-mail to the IBM support
system. The optional e-mail to the IBM support system is sent to your SMTP mail
server and then forwarded to the IBM support system, where it is converted into a
problem record.

[Figure 2 on page 5 shows the service alert architecture for SAN Volume Controller.
Note that the path to the system administrator (as shown in [Figure 3 on page 5) is
not shown in this figure:
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Figure 2. Service alert architecture for SAN Volume Controller
SAN File System

For SAN File System, service alert notifies the system administrator of significant
errors or failure conditions. SAN File System issues an Simple Network
Management Protocol (SNMP) trap and sends that trap to the IBM Director Server
running on the master console in response to a sever error condition. The IBM
Director Server catches the trap and converts it into a Simple Mail Transfer
Protocol (SMTP) e-mail message. The e-mail message is then sent to your SMTP
mail server and then forwarded to the system administrator. The system
administrator can then call the IBM Support Center.

This figure shows the service alert architecture for SAN File System:

Customer
L]
[ Sy
4 Administrator
B

A [T

Master SMTP

console mail
— server
SAN File

System

Figure 3. Service alert architecture for SAN File System

Secure Shell (SSH)

This topic provides an overview of Secure Shell (SSH).

Secure Shell (SSH), which is implemented through PuTTY, is the communication
vehicle between the host system that you are using and the following components:

* The SAN File System command-line interface (CLI)
* The SAN Volume Controller CLI

e The master console.
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* Each of the metadata server engines in the SAN File System cluster, using SSH
from the master console.

SSH provides a secure communications channel between systems. You can
configure SSH to use a private/public key pair to establish the secure connection
This private/public key pair is required for SAN Volume Controller, but it is
optional for SAN File System.

If you are using a private/public key pair, the public key must be placed on any
system to which you want to create an SSH connection (such as the SAN Volume
Controller nodes or the SAN File System metadata servers and clients). In addition,
any system to which you want to create an SSH connection must be running an
SSH server.

Software components

This topic describes the software components that are provided for the master
console.

The following software is provided for the master console:

* Adobe Acrobat Reader

-+ DB2®

* DS4000 Storage Manager Client (FAStT Storage Manager Client)
 IBM Director

e PuITY

* SAN Volume Controller Console

* Tivoli Storage Area Network Manager (Tivoli SAN Manager)

e IBM VPN Connection Manager

6  Master Console Installation and User’s Guide



Chapter 3. Planning for the master console

This topic provides an overview of the planning tasks you need to complete before
you install and configure the master console.

Note: The hardware-related prerequisites in this section are relevant only when
you are installing and configuring the master console software on hardware
of your choice (that is, when you have purchased only the master console
software).

Perform the following steps to plan for the installation of the master console:
* Verify that you have met the hardware and software prerequisites.

* Determine the cabling required for your configuration.

¢ Determine how the ports on the master console will be configured.

* Determine the IP addresses to be used for the master console.

¢ Determine the switch zoning that will be used for the master console.

It is recommended that the master console must be in the same room as the
devices that are supported by the master console. In addition, it is recommended
that it be placed within 50 feet of the SAN File System metadata servers or SAN
Volume Controller nodes.

Master console prerequisites

This topic defines the hardware and software prerequisites that you need to obtain
for the master console.

Hardware prerequisites

SAN File System supports a single master console that can be shared with other
IBM TotalStorage products, such as SAN Volume Controller. If you do not already
have a master console, you must obtain a rack-mounted, high-performance,
highly-reliable Intel " server (such as the IBM eServer ~ xSeries® 306 or equivalent)
with the following options:

¢ One Pentium® 4 processor, minimum 2.6 GHz.
* Minimum of 2 GB of system memory.

¢ Two IDE hard disk drives, minimum 40 GB each. During installation, you will
mirror these drives.

e CD-ROM and diskette drives.
* Two 1Gb ports for Ethernet connections (fiber or copper).

* One 2Gb Fibre Channel host bus adapter (HBA) port, such as QLogic 2342 (dual
port) or QLogic 2340 (single port) FC-2 cards or equivalent.

¢ Keyboard, such as the Space Saver NLS keyboard or equivalent.

* Monitor, such as Netbay 1U Flat Panel Monitor Console kit without keyboard or
equivalent.

* Mouse or equivalent pointing device.

© Copyright IBM Corp. 2004, 2005 7



Example hardware configuration

IBM xSeries 306 server (1U).

Intel Pentium 4 3.0 GHz processor.

2 GB memory DIMM (256 MB comes with base unit).

Two 70 GB IDE hard disk drives (one comes with base unit).
Two 10/100/1000 Copper Ethernet ports on planar.

One 1-port 1/2 Gb/s Fibre Channel host bus adapter.

NetBay 1U Flat Panel Monitor Console Kit with US keyboard.

Software prerequisites

The master console requires that you obtain the following software:

* Operating system

— The hardware master console is shipped with Windows Server 2003
preinstalled.

— The software master console requires that one of the following operating
systems is provided on your hardware platform:
- Microsoft Windows Server 2003 Enterprise Edition
- Microsoft Windows Server 2003 Standard Edition
- Microsoft® Windows® 2000 Server Edition with Service Pack 4 or higher.
- Microsoft Windows 2000 with Update 818043. To obtain this update:

1.

NoOokwN

Point your browser to this Web site:

[v4.windowsupdate.microsoft.com/catalog/en/default.asp|

Click Find updates for Windows operating systems.

Select Windows 2000 Professional SP4.

Select Advanced Search.

In the field, Contains these words, enter 818043, and then click Search.
Follow the directions on the Web site to download the update.

After you download the update, you will need to navigate to the
location where the update was downloaded and run the .exe file to
install the update.

* Microsoft Windows Internet Explorer version 6.0 with Service Pack 1.

* Antivirus software (not required but strongly recommended).
+ J2SE Java' Runtime Environment (JRE) 1.4.2.
You can obtain JRE 1.4.2 by going to the following Web site and then clicking

Downloads, Java & Technologies, Java 2 Platform, Standard Edition 1.4, and
then Download J2SE JRE:

[www.sun.com /|

Hardware master console configuration steps

This topic describes the general steps needed to configure the master console when
you have purchased it preinstalled on hardware.

The configuration steps that need to be performed for the hardware master console
are:

1. Log on to the master console.

2. Configure the network.

3. Configure the browser.
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Generate an SSH key pair using the SSH client called PuTTY.
Configure the PuTTY session for command-line interface (CLI) access only.
Start the SAN Volume Controller Console for the SAN Volume Controller.

Store the master console SSH public key file on each SAN Volume Controller
cluster.

N o ok~

8. Configure the master console host name. Note that this procedure is not the
same on the software and the hardware master consoles.

9. Set up a new zone on the fibre-channel switches that includes the master
console and all of the 2145 ports.

10. Start the Tivoli SAN Manager.

11. Set up Remote Support.

12. Start IBM Director.

13. Modify your IBM Director settings.

14. Configure your IBM Director for the SAN Volume Controller Call Home and
Event Notification

15. Upgrade software on the master console.
16. Install antivirus software.

Specific details for the completion of these steps are described in this guide.

Cabling options

This topic describes the various options for cabling the master console.

There are a variety of ways to cable a master console, depending on your
environment:

* A single master console that is used for a single SAN File System or SAN
Volume Controller installation.

* A single master console that is shared between a SAN File System installation
and a SAN Volume Controller installation.

* Two master consoles, one for a SAN File System installation and one for a SAN
Volume Controller installation.

In all cases, the ports on the master consoles are cabled as follows:
* One Ethernet port is cabled to your corporate intranet.

* One Ethernet port is cabled to the Internet through a corporate firewall. This
port will be used for remote access functionality.

Cabling a single master console

This topic illustrates a cable configuration in which you have a separate master
console for SAN File System and SAN Volume Controller.

The following figure shows how you can cable a single master console that is used
by a single SAN File System or a single SAN Volume Controller installation:
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Figure 4. Cabling a single master console

Cabling a shared master console

This topic illustrates how to cable a master console that is shared between the SAN
File System and the SAN Volume Controller.

[Figure 5 on page 11|shows how you can cable a master console in a shared
environment:
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Figure 5. Cabling a shared master console

Cabling multiple master consoles

This topic illustrates a cable configuration in which you have a separate master
console for SAN File System and SAN Volume Controller.

The following figure shows how you can cable multiple master consoles; one for

each installation of SAN File System and one for each installation of SAN Volume
Controller:
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Figure 6. Cabling multiple master consoles

Specifying port assignments

This topic describes the port assignments that you specify for the master console.

Complete the port assignment table for the master console. Use these port
assignments to determine the number of Ethernet and Fibre Channel cables that
you will need.

When filling out the port assignment table, as shown in use the following
descriptions

* Ethernet port 1: Used for your VPN connection. This port is required if you
configure your master console to enable remote access. A remote access
connection can only be enabled when this port has access to an external Internet
connection. For added security you can disconnect this port when a remote
access connection is not being used.

* Ethernet port 2: Used to connect to the same IP network to which the SAN
Volume Controllers or SAN File System metadata server engines are connected.

* Fibre channel port 1 or 2: Used to connect to a fibre channel switch in one SAN
Volume Controller or SAN File System fabric.

Table 1. Port assignment table

Master console

Ethernet Fibre channel port 1 | Fibre channel port 2

VPN Public Network

[Table 2 on page 13 shows a port assighment table with data:
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Table 2. Port assignment table when filled in

Master console

Ethernet Fibre channel port 1 | Fibre channel port 2

VPN Public Network

Master console

Ethernet hub 1, port 6 | Ethernet hub 1, port 5 | FC switch 1, port 9

Specifying IP information

This topic describes the IP configuration information that you specify for the
master console.

Complete the master console IP configuration worksheet for the master console.
When filling out the port assignment table, use the following descriptions.

* Machine name: A fully-qualified Domain Name Server (DNS) name for the
master console.

e Master console IP addresses : The addresses that will be used for access to the
master console.

* Gateway IP address: The default gateway IP address used by the master
console.

* Subnet mask : The subnet mask for the master console.

Master console IP configuration worksheet

Master console IP configuration worksheet

Machine name:

Ethernet port 1 Ethernet port 2

Master console IP address

Gateway IP address

Subnet mask

Fibre channel zoning considerations

This topic provides an overview of the fibre channel zoning considerations for the
master console.

Zoning considerations for SAN Volume Controller

This topic provides fibre channel zoning considerations for the SAN Volume
Controller.

If you are using the master console with the SAN Volume Controller, you need to
create a new fibre channel switch zone that contains the master console and all of

the SAN Volume Controller fibre channel ports.

For hosts, use switch zoning to ensure that each host fibre-channel port is zoned to
exactly one fibre-channel port of each SAN Volume Controller node in the cluster.

For more information on zoning your switches, refer to IBM TotalStorage SAN
Volume Controller Configuration Guide.
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Configuring firewall support

This topic provides information about your firewall configuration.

Local Area Connection 1 on the master console must be allowed to connect to the
IBM Remote Support Gateway through UDP port 500 and UDP port 1701. If you
have a NAT (network address translation) firewall, you will also need to allow
Local area connection 1 on the master console to connect to the IBM Remote
Support Gateway through UDP port 4500.

Note: For Remote Support to work, a maximum of two ports will need to be
permitted to connect to the Local Area Connection 1 on the master console.
Check with your network system administrator to find out if you have
access to the necessary ports and to gain access if necessary.

Ports and protocol requirements:
« L2TP - UDP 500, UDP 1701

* NAT-T - UDP 4500

* ESP - IP protocol 50
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Chapter 4. Installing master console software

This topic describes the procedures for installing the master console software.

Before you begin: Before installing the master console software, you should have
completed the following tasks (note that if you have purchased the hardware
preinstalled with the master console software, you can skip most of the tasks in
this chapter and proceed with [Chapter 5, “Configuring the master console,” on|
¢ Installed all hardware prerequisites in the master console.
¢ Cabled the master console.
¢ Installed all software prerequisites.
* Enabled SNMP services by completing the following steps:
1. Click Start -> Programs -> Control Panel.
2. Double-click Add or Remove Programs.
3. Select Add/Remove Windows Components.
4. Click on the text for Management and Monitoring Tools and click Details.
5. Click the check box for Simple Network Management Protocol and click OK.

In addition, you should view the release notes for the master console software
(available on the IBM support Web site) for the latest information.

You can use the installation wizard to assist you in installing the master console
software.

Perform these steps to install the master console:

1. Use the port assignment information and cabling options to cable the master
console.

2. Use the IP configuration information to enter the host name and IP addresses.

3. Start the installation wizard to install the master console software.

Important: It is strongly recommended that the master console software be the
only software installed on the hardware that you are using for the
master console.

Setting up the master console

This topic provides an overview of the steps that are required to set up the master
console in preparation for installing master console software.

Perform the following steps to set up the master console:
1. Connect the fibre channel cables.

2. Configure the IP address for the Ethernet port that is to be connected to the
external Internet (Ethernet port 1).

3. Configure the IP address for the Ethernet port that is to be connected to the
internal IP network (Ethernet port 2).

4. Configure the host name for the master console.

5. Install the SNMP service (if you did not install it when you installed the
operating system).
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Connecting the fibre channel cables
This topic describes how to cable the fibre channel ports.
1. Verify that no cables are connected to the Ethernet ports.

2. Connect the fibre channel cables from the master console to an unused fibre
switch port.

Note: For SAN Volume Controller users: The recommended configuration for
SAN Volume Controller is that it should be connected to two
independent SANSs. The configuration of the second SAN should
duplicate the first SAN. To enable problem determination of SAN
problems, Tivoli SAN Manager on the master console needs to have
access to both SANs through the fibre channel ports. Hence, one of the
fibre channel cables from the master console must be connected to a fibre
channel switch on the first SAN and the other cable should be connected
to a fibre channel switch on the second (duplicate) SAN.

Entering IP address for Ethernet port 1

This topic describes how to configure the IP address for the external Internet
connection for Remote Access (Ethernet port 1).

Tip: After configuring the connection, you can disable it when you are not using
remote access.

From the desktop, right-click on the My Network Places icon.
Select Properties.

Right-click Local Area Connection 1.

Select Properties.

Select Internet Protocol (TCP/IP).

Select Properties.

Enter all required information for the IP and DNS addresses.

© N OokA N~

Connect Ethernet port 1 to the network.

Entering IP address for Ethernet port 2

This topic describes how to configure the IP address for the internal IP network
connection (Ethernet port 2).

From the desktop, right-click on the My Network Places icon.
Select Properties.

Right-click Local Area Connection 2.

Select Properties.

Select Internet Protocol (TCP/IP).

Select Properties.

Enter all required information for the IP and DNS addresses.

© N oA OND =

Connect Ethernet port 2 to the network.

Setting up the master console host name
This topic describes how to configure the master console host name.
1. From the desktop, right-click on the My Computer icon.
2. Select Properties.
3. Select Network Identification.
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Select Properties.
Enter the master console name in the Computer name field.
Select More.

Enter the Full path information in the Primary DNS suffix of this computer
field.

N o o s

Setting up the browser

This topic describes the Internet browser configurations.

Perform the following steps to configure the browser:

1. Ensure that the browser allows new windows (pop-ups) to automatically open
when you visit a Web site.

2. Uninstall or turn off any applications on the browser that block or suppress
pop-up windows.

Installing the SNMP service

This topic describes how to install the SNMP services.

You need to install the SNMP service if it was not installed when you installed the
operating system. Perform the following steps to install the SNMP service:

1. Click Start-->Settings-->Control Panel.
2. Double-click Add/Remove Programs.
Click Add/Remove Windows components on the left side of the panel.
Click Management and Monitoring Tools, and then click Details.
Check Simple Network Management Protocol, and click OK.
Click Next to complete the installation process.
From the Control Panel, double-click Administrative Tools.
Double-click Computer Management.

9. Expand Services and Applications.
10. Click Services.
11. In the list of services, double-click SNMP Service.
12. On the General tab, select Automatic as the Startup Type.

13. On the Security tab, click the Add button underneath the Accepted
Community Names field, and enter public as the new community name and
leave the community rights as read-only. If the Master Console is running on
a Windows 2003 system, select the Accept SNMP packets from any host
radio button.

Note: On Windows 2000, Accept SNMP packets from any host is the default.
On Windows 2003, the default is Accept SNMP packets from these
hosts, with an empty field underneath. This default results in the
NetView® part of the installation failing.

Using the installation wizard

This topic describes the installation process and lists the programs that you can
install using the installation wizard.

Chapter 4. Installing master console software 17



The master console installation wizard provides the framework for installing all of
the software that is required for the master console. It ensures that the master
console meets all prerequisites and launches the installation program for each of
the software products being installed.

Important: During the installation process, some products require a system reboot
after they are installed. Any time you are prompted to reboot the
system, you should do so. After each system reboot, the Master
Console installation wizard will continue the installation process from
the point it was interrupted by the required reboot.

The installation wizard helps you to install the following products:

* Adobe Acrobat Reader

e PuTTY

* DB2

* SAN Volume Controller console (optional)

* DS4000 Storage Manager Client (FAStT Storage Manager Client) (optional)
* Tivoli Storage Area Network Manager (Tivoli SAN Manager)

* IBM Director

You must use the master console CD-ROMs to install the master console software.

Logging in
This topic describes the permissions required to perform the master console
installation

To begin installing software on the master console, you must be logged in as a
local administrator (for example, as the user, Administrator) on the system where
the master console software will be installed.

Starting the installation wizard
This topic describes the steps for starting the installation wizard.

Before you begin: Ensure that you have logged in with a user ID that has
administrative privileges.

1. Insert the Master Console CD-ROM 1 in the CD-ROM drive.
2. Click Start—>Run to open the Run dialog.

3. Enter cd-rom_drive:\setup.exe, where cd-rom_drive is the letter of the drive in
which you inserted the CD. Click OK.

The following message is displayed in the DOS-prompt window.

Initializing InstallShield Wizard...
Preparing Java (tm) Virtual Machine .........ccccoevee...

4. When prompted, select the language to be used for the installation wizard and
click OK.

5. The installation wizard Welcome panel is displayed. Read the information from
the panel and then click Next.

6. The installation wizard License Agreement panel is displayed. Click I accept
the terms in the license agreement, and then click Next to begin installing the
Adobe Acrobat Reader.
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Note: Before Adobe Acrobat Reader is installed, the program makes some
checks as follows:

a. The installation wizard verifies that all software prerequisites are
installed on the system. If not, a pop-up opens describing the
prerequisites that are not currently installed. When you click OK, the
installation wizard exits.

After installing the prerequisite software, start the installation wizard
again.

b. If any hardware requirements are not met on your system, a panel is
displayed stating the hardware requirements that are not met and
warning about a decrease of the performance level if these
requirements are not met.

Installing the Adobe Acrobat Reader

This topic describes how to install the Adobe Acrobat Reader using the master
console installation wizard.

Adobe Acrobat Reader 6.0 is silently installed by the installation program. It
provides access to documentation, such as this document, through a popup
window.

When the installation is complete, an information window appears. From this
window, you can access this document or IBM Support Web sites by right-clicking
on the left side of the window.

Click Next to select the destination directory where the master console will be
installed.

Choosing the master console destination directory

This topic describes how to choose the directory where the master console software
will be installed.

Perform the following steps to choose the destination directory:

1. By default, the master console is installed in c:\Program
Files\IBM\MasterConsole. To choose a different directory, click Browse and
select a different directory from the Select a directory dialog.

2. After selecting the destination directory, click Next to display the master
console information center port selection panel.

Selecting the port for the information center

This topic describes how to select the port value needed to access the master
console information center.

Perform the following steps to select a port value:

1. Enter a port value between 1 and 65535. To ensure that the port value is not in
use by another application on your system, open a command prompt and enter
the command netstat —a to see which port values are in use.

2. After entering the information center port value, click Next to display the list of
optional products that you can select to be installed for the master console.

Selecting the optional features

This topic describes how to select the optional features to be installed by the
master console wizard.
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Select those optional features you want to install and deselect those optional
features you do not want to install:

1. Install DS4000 Storage Manager Client (FAStT Storage Manager Client)

If DS4000 Storage Manager Client (FAStT Storage Manager Client) is deselected,
a message is displayed when you click the Next button to warn you that this
feature should be deselected only when DS4000 disk drives are not part of the
current configuration.

2. Install SAN Volume Controller Console

If SAN Volume Controller Console is deselected, a message is displayed when
you click the Next button to warn you that this feature should be deselected
only when SAN Volume Controller Console is not part of the current
configuration.

After selecting or deselecting the optional features, click Next to display the list of
products that will be installed for the master console.

Viewing the products to be installed

This topic describes the panel that displays the list of products to be installed for
the master console, and it explains the steps needed to proceed with the master
console installation process.

Using the list of products to be installed for the master console, the installation
wizard determines if any of these products are already installed and, if so, whether
the installed version is later than the version to be installed. The Product List panel
lists the results:

* Products of the master console stack

* Versions of the already installed products

* Required versions for the products

* Actions to be done by the installation wizard or by the user

The table containing the list of the products to be installed or upgraded is saved as
MasterConsoleProducts.htm in the location where the master console is installed.

Depending on the installed version of each product, the installation wizard will
determine whether to install the product based on the following conditions:

¢ If the product is not installed or its installed version is lower than the desired
version, the product is installed or upgraded by launching the specific installer
of the product.

* If the product is installed at a version equal to or higher than the desired
version, the product is left as is. The corresponding panels that launch and
verify the specific product installation are skipped. For the products with higher
versions than the required ones, the installation wizard displays a warning
telling you that these products were not tested with the master console.

* If a product in the list of products to be installed or upgraded is found to be not
properly installed on the system, you are asked to continue with the installation
by trying to reinstall the product with the product-specific installer. If this action
does not succeed, you need to exit the master console installation wizard,
manually remove the product from your system, and restart the master console
installation wizard.
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e For DB2, the installation wizard also checks the installed edition. If the installed
edition is not "Enterprise Edition,” the installation wizard inserts “*Wrong
edition” in the Installed Version column. You must manually uninstall the wrong
installed edition.

To manually uninstall the wrong installed edition:
1. Click Cancel to exit the master console installation wizard.
2. Manually uninstall the wrong DB2 edition.

3. After uninstalling the wrong edition of DB2, start the master console
installation wizard again.

From this panel, click Next to begin installing PuTTY.

Installing PuTTY

This topic describes how to install PuTTY using the master console installation
wizard.

Perform the following steps to install PuTTY:

1. From the PuTTY installation panel, click Next to begin the installation of
PuTTY.

2. The installation wizard installs PuTTY silently. Wait for the wizard to complete
the installation.

3. From the master console installation wizard, click Next. The installation wizard
validates the installation of PuTTY. If the validation is not successful, an error
panel is displayed. If errors were found, correct the errors and start the
installation wizard again.

Before continuing with the installation wizard, you should create a public and
private key using PuTTY. You will need these keys when you install the SAN
Volume Controller Console.

Generating an SSH key pair using PuTTY

This task describes how to generate SSH keys using PuTTY on the master console.

Although not part of the master console installation wizard, you need to generate
SSH keys to be used for the SAN Volume Controller. You will be prompted for
these keys when you install the SAN Volume Controller console. You can leave the
installation wizard in its current state while you generate the SSH keys.

Perform these steps to generate SSH keys on the master console:

1. Start the PuTTY Key Generator. Click Start —>Programs —> PuTTY —>
PuTTYgen.

2. Click SSH2 RSA as the type of key to be generated.
Click Generate.

Move the cursor around the blank area of the Key section to generate a
random number.

W

Click Save public key to save the public key.
Enter icat as the name of the key and click OK.
Click Save private key to save the private key.
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When prompted to confirm that you want to create the key without a
passphrase, click Yes.

9. Enter icat.ppk as the name of the key and click OK.
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10. Close the PuTTY Key Generator.

Installing DB2

This topic describes how to install DB2 using the master console installation
wizard.

Perform the following steps to install DB2:

1. From the Launch DB2 Installation panel, click Next to begin the installation of
DB2.

2. If prompted to insert a different CD, insert it in the CD-ROM drive and enter
the CD-ROM drive letter in the location field. Then click OK.

3. The DB2 setup wizard starts. Using the DB2 setup wizard, perform these steps
to install DB2:

a. From the Welcome to the DB2 Setup Wizard panel, click Next.

b. From the License Agreement menu, accept the terms of the license
agreement and then click Next .

c. From the Select the installation type menu, click Next to accept the default
values.

d. From the Select the installation action menu, click Next to accept the default
value.

e. From the Select installation folder menu, click Next to accept the default
destination.

f. From the Set user information for the DB2 Administration Server menu, you
can use the default user name (db2admin). However, you will need to
specify a password.

Note: Ensure that Use the same user name and password for the
remaining DB2 services is selected. This allows you to use this same
user name and password for the remainder of the DB2 installation.
Otherwise, you will be prompted to enter a user name and password
for several additional menus.

g. Click Next. If you are prompted to create the user, click Yes.

h. From the Set up the administration contact list menu, select Local + Create
a contact list on this system, and then click Next.

Note: If you receive a warning stating that the SMTP server has not been
specified, click OK to continue.

i. From the Configure DB2 instances menu, select DB2 from the DB2 Instances
list, and then click Next.

j. From the Prepare the DB2 tools catalog menu, click Do not prepare the DB2
tools catalog on this computer and then click Next .

k. From the Specify a contact for health monitor notification menu, click New
contact, and enter the appropriate information in the Name and Email
address fields.

I. Click Next.
m. From the Start copying files menu, click Install to begin installing DB2.
n. Click Finish to complete the installation.

0. When the IBM DB2 Universal Database’~ Welcome menu starts, click Exit
First Steps.

4. From the master console installation wizard, click Next to verify DB2
installation. The installation wizard validates the installation of DB2. If the
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validation is not successful, an error panel is displayed. If errors were found,
correct the errors and start the installation wizard again.

Installing SAN Volume Controller console

This topic describes how to install the SAN Volume Controller console using the
master console installation wizard.

Perform the following steps to install the SAN Volume Controller console:

1. From the master console installation wizard, click Next to launch the SAN
Volume Controller Installer wizard.

2. From the SAN Volume Controller Installer wizard, perform these steps to
install the SAN Volume Controller Console:

a.
b.

From the Welcome panel, click Next.

From the License Agreement panel, click I accept the terms of the license
agreement, and then click Next.

From the Destination Directory panel, click Next to accept the default
directory.

From the PuTTY configuration panel, enter the private key (default is
icat.ppk) that you created after installing PuTTY. Then, click Next.

From the CIMOM ports menu, click Next to accept the default ports.

From the embedded WebSphere Application Server ports menu, click Next
to accept the default ports.

From the installation confirmation menu, click Install to install the SAN
Volume Controller console.

Click Finish to complete the installation.

Note: If View post installation tasks is clicked, you can view the steps
needed to access the SAN Volume Controller console.

3. From the master console installation wizard, click Next. The master console
installation wizard validates the installation of the SAN Volume Controller
Console. If the validation is not successful, an error panel is displayed. If errors
were found, correct the errors and start the installation wizard again.

Installing the DS4000 Storage Manager Client (FAStT Storage
Manager Client)

This topic describes how to install the DS4000 Storage Manager Client (FAStT
Storage Manager Client) using the master console installation wizard.

Perform the following steps to install the DS4000 Storage Manager Client (FAStT
Storage Manager Client):

1. From the master console installation wizard, click Next to start the installation
of the DS4000 Storage Manager Client (FAStT Storage Manager Client).

When upgrading the DS4000 Storage Manager Client (FAStT Storage Manager
Client) from a version lower than version 9, the installation wizard

automatically uninstalls the old version first and then begins the installation of
the new version, as follows:

a.

The DS4000 Storage Manager Client (FAStT Storage Manager Client)
uninstallation panel is displayed. Click Next to remove the old version of
the product from the system.
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b. The DS4000 Storage Manager Client (FAStT Storage Manager Client)
uninstallation verification panel is displayed. Click Next to verify that the
product was successfully removed from the system.

c. The DS4000 Storage Manager Client (FAStT Storage Manager Client)
installation panel is displayed. Click Next to begin installing the new
version of the product.

2. From the DS4000 Storage Manager Client (FAStT Storage Manager Client)
installation wizard, perform these steps to install the client:

a. From the Welcome panel, click Next.

b. At the copyright prompt, click OK.

c. From the License Agreement panel, click Yes.
d

. From the Destination Directory panel, click Next to accept the default
directory.

e. When prompted to start the Event Monitor service, click Yes.
f. From the Operation Complete panel, click Finish.

3. From the master console installation wizard, click Next. The master console
installation wizard validates the installation of the DS4000 Storage Manager
Client (FAStT Storage Manager Client). If the validation is not successful, an
error panel is displayed. If errors were found, correct the errors and start the
installation wizard again.

Installing Tivoli SAN Manager

This topic describes how to install the Tivoli SAN Manager using the master
console installation wizard.

Before you begin installing Tivoli SAN Manager, you must ensure that the SNMP
service is started and that a public community string is defined. In addition, you
must ensure that SNMP Trap service is set to manual and stopped. To view the
services:

Right-click My Computer from the desktop, and then click Manage.
Expand Services and Applications.

Click Services.

Select SNMP Service and verify that the status is set to started.
Right-click SNMP Service and click Properties.

Click the Security tab and verify that there is a public community name with a
minimum of Read rights.

Click OK to close the SNMP Service properties dialog.

From the list of services, select SNMP Trap Service. Verify that the status is not
set to started and that the startup type is set to manual.
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Perform the following steps to install the Tivoli SAN Manager:

1. From the master console installation wizard, click Next to start the installation
of IBM Tivoli Storage Area Network Manager.

2. If prompted to insert a different CD, insert it in the CD-ROM drive and enter
the CD-ROM drive letter in the location field. Then click OK.

3. From the Tivoli Storage Area Network Manager setup wizard, perform these
steps to install Tivoli Storage Area Network Manager:

a. Select the language to be used for the installation, and click OK.
b. At the copyright prompt, click OK.
c. From the Welcome menu, click Next.
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d. From the License Agreement panel, click I accept the terms in the license
agreement, and then click Next.

e. From the Destination Directory panel, click Next to accept the default
directory.

f. From the base port number panel, click Next to accept the default.
g. From the data repository panel, click DB2, and then click Next.

h. From the Single/Multiple User ID/Password Choice panel, you can decide
to use the DB2 Administrator username and password you specified during
the DB2 installation for all IDs and passwords on this panel. You can also
choose to use different IDs and passwords for each of the IDs and
passwords on this panel. After choosing, click Next.

i. Enter the DB2 Administrator username and password. Confirm the
password and click Next.

Note: If you chose not to use the DB2 Administrator username and
password, you will be prompted for enter IDs and passwords for
DB2, Websphere, host authentication, and NetView.

j. From the database name panel, click Next to accept the default.

k. From the Tivoli Network installation drive menu, click Next to accept the
default.

|. From the installation confirmation menu, click Next.

m. When prompted, click Finish to complete the installation of the Tivoli SAN
Manager. Note that the machine will reboot and the master console
installation wizard will continue.

From the master console installation wizard, click Next. The master console
installation wizard validates the installation of Tivoli SAN Manager. If the
validation is not successful, the Verify Tivoli SAN Manager Installation panel
displays an error. Correct all errors and restart the master console installation
wizard.

Before you continue with the master console software installation, you need to
disable the NetView component of Tivoli SAN Manager from receiving traps from
the Windows SNMP Trap Service. Both NetView and IBM Director receive traps on
the same port by default, which will cause a conflict when SNMP traps are sent
from SAN File System or SAN Volume Controller. Therefore, you need to configure
IBM Director to forward traps to NetView (you will configure IBM Director to
forward traps after installing it).

To disable the NetView component from receiving SNMP traps:

1.

Edit the Windows registry by opening a DOS prompt and entering regedit
from the command line.

Locate the key
HKEY _LOCAL_MACHINE\SOFTWARE\Tivoli\NetView\CurrentVersion.

Double-click the trapdSharePort162 value name and change its value data to
0.

Right-click the key
HKEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView \CurrentVersion and
click New » DWORD Value.

Change the value name to trapdTrapReceptionPort.

Double-click the trapdTrapReceptionPort value name, change its value data to
an available port number, such as 9950 and click the Decimal radio button.
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10.

Tip: Remember the port number that you set here. You will refer to that
number when you modify the IBM Director configuration.

Close the Registry Editor window.
Open a Command Prompt window.
Remove the NetView service.
C:\usr\ov\bin\nvservice -remove

Reinstall the NetView service (which will remove the dependency on the
SNMP Trap Service).

C:\usr\ov\bin\nvservice -install -username .\NetView -password password

where password is the password of the local NetView account.

Installing Tivoli SAN Manager Agent

This topic describes how to install the Tivoli SAN Manager agent using the master
console installation wizard.

Perform the following steps to install the Tivoli SAN Manager agent:

1.

From the master console installation wizard, click Next to begin the installation
of the Tivoli SAN Manager agent.

If prompted to insert a different CD, insert it in the CD-ROM drive and enter
the CD-ROM drive letter in the location field. Then click OK.

Select the language to be used by the Tivoli SAN Manager Agent Setup Wizard,
and click OK.

The Tivoli SAN Manager Agent Setup Wizard is launched. From the Setup
Wizard perform these steps to install the Tivoli SAN Manager Agent:

a. From the Software License Agreement panel, click I accept the terms in the
license agreement, and click Next.

b. From the Installation Directory panel, click Next to accept the default
directory.

c. From the Manager name and port number panel, enter localhost for the
Tivoli Manager name (because both the Manager and the Agent are on the
master console). Leave the default for the Port Number, and click Next.

d. From the Base Port Number panel, click Next to accept the default.

e. From the Host Authentication Password panel, enter the password of the
Host Authentication ID you specified when you installed Tivoli SAN
Manager - Manager.

Note: If you chose to use the DB2 Administrator username and password
for all IDs when you installed the Tivoli SAN Manager, enter it on
this panel as well. Otherwise, enter the ID that you specified for the
host authentication ID when you installed the Tivoli SAN Manager.

f. From the Installation Confirmation menu, click Next.

g. Click Finish to complete the installation of the Tivoli SAN Manager Agent.
From the master console installation wizard, click Next. The master console
installation wizard validates the installation of Tivoli SAN Manager agent. If
the validation is not successful, the Verify Tivoli SAN Manager Agent

Installation panel displays an error. If errors were found, correct the errors and
restart the master console installation wizard.
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Installing IBM Director

This topic describes how to install IBM Director using the master console
installation wizard.

Perform the following steps to install IBM Director:

1.

From the master console installation wizard, click Next to begin the installation
of IBM Director.

If prompted to insert a different CD, insert it in the CD-ROM drive and enter
the CD-ROM drive letter in the location field. Then click OK

The IBM Director Setup Wizard is launched. From the Setup Wizard perform
these steps to install IBM Director:

a. From the License Agreement panel, click I accept the terms in the License
Agreement, and click Next.

b. From the Server Plus Pack panel, click Next.

c. From the Feature and Installation Directory panel, click the Red x for SNMP
Access and Trap Forwarding. Click This Feature will be installed on the
local hard drive, and click Next.

d. From the IBM Director service account information panel, fill in the
following fields:

* Domain. Enter the host name for the master console.
¢ User name. Enter a Windows user account that has administrative
privileges.
* Password. Enter the password for the Windows user account (and
confirm it).
Then click Next.
e. From the Encryption Settings panel, click Next to accept the defaults

f. From the Software distribution settings panel, click Next to accept the
defaults.

g. Click Install to begin the installation.

h. From the Network Drivers configuration pop-up, select the first port and
click Enable driver.

i. From the IBM Director database configuration, make sure that Microsoft Jet
4.0 is selected (it is the default). Do not select DB2 here. Then click Next.

j. Click Finish to complete the installation.
k. When prompted to reboot the system, click No.

|. From the master console installation wizard, click Next. The master console
installation wizard validates the installation of IBM Director. If the validation
is not successful, the Verify IBM Director Installation panel displays an error.
Correct all errors and restart the master console installation wizard.

After completing the installation and before continuing with the master console
installation wizard, you need to configure IBM Director to forward traps to the
NetView component of Tivoli SAN Manager.

1.
2.

Open a Command Prompt window.
Change to the IBM Director snmp directory.
cd Director_installation_directory\data\snmp

where Director_installation_directory is C:\Program Files\IBM\ Director by
default.

Edit SNMPServer.properties.
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4. Find the line snmp.trap.vl.forward.address.1=.

5. Uncomment the line (delete the # sign), and add the name of the master
console machine. For example:
snmp.trap.vl.forward.address.l=masterl

6. Find the line snmp.trap.vl.forward.port.1=.

7. Uncomment the line (delete the # sign), and add the port that you specified for
the trapdTrapReceptionPort value in the Windows registry key
KEY_LOCAL_MACHINE\SOFTWARE\Tivoli\NetView \CurrentVersion\. For
example:
snmp.trap.vl.forward.port.1=9950

8. Save and close the file.

9. Reboot the master console.

Preconfiguring IBM Director

This topic describes how the master console installation wizard performs some
preconfiguration tasks for IBM Director.

IBM Director preconfiguration tasks consist of creating a set of event action plans
designated for managing specific events generated by the master console system.
These action plans are imported from configuration archive files that should exist
on the master console installation package.

Perform the following steps to launch the IBM Director preconfiguration tasks:

1. If at least one of the event action plans is in the installation package, you are
asked to provide, in the Superuser account panel, a Director superuser
(member of DirSuper group) name and password needed in the IBM Director
preconfiguration process.

Provide the name and password, and click Next to continue.

2. Wait for the master console wizard to restart IBM Director and to discover IBM
Director-managed systems.

3. The installation wizard finishes the preconfiguration tasks. If one or more
configuration files are not found in the installation package, or if an error
occurs during the creation of event action plans, a message is displayed in a
panel warning the user that these action plans must be manually created later,
after the installation is completed.

Click Next to continue.

For more information about configuring IBM Director for SAN Volume
Controller, see [“Configuring service alert for SAN Volume Controller” on page|

For more information about configuring IBM Director for SAN File System, see
[“Configuring service alert for SAN File System” on page 36

After the master console installation wizard has completed the preconfiguration
tasks for IBM Director, you need to complete the following steps to ensure that the
local system account can log on to IBM Director:

1. Close IBM Director.

2. Right-click My Computer from the desktop, and then click Manage.
Expand Services and Applications.

Click Services.

Right-click IBM Director Server and click Properties.

Select the Log On tab.

ook~ w
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9.
10.

Click Local System account and select Allow service to interact with
desktop.

You are prompted that the new properties will not take effect until you stop
and restart the service. Click OK at the prompt.

Click OK to close the Properties dialog.
Stop the IBM Director service, and then restart it.

Installing Documentation and Support Utilities

This topic describes how to use the master console installation wizard to install the
master console documentation, Document Launcher, Connection Manager,
configuration files, IBM WebSphere Help System, and create the directories
structure and icons.

Perform the following steps to copy the documentation files and to install the

utilities:

1. From the master console installation wizard, click Next to begin installing the
documentation and support utilities.

2. If prompted to insert a different CD, insert it in the CD-ROM drive and enter
the CD-ROM drive letter in the location field. Then click OK.

3. The documentation and support utilities are copied.

4. The installation wizard installs Connection Manager, loads registry info and
creates the IBM VPN client object.

5. The installation wizard copies Eclipse files of IBM WebSphere Help System
and installs the master console information center (copies master
console-specific documentation into the IBM WebSphere Help System).

6. The program installs the IBM master console information center as a service.

7. After all documentation and utilities are installed, the Finish panel is
displayed.

8. Review the master console installation log (mclog.txt) to ensure that all

9.
10.

products are properly installed. The log file is located in
<installation_directory>\logs, where <installation_directory> is the directory
where the master console was installed. The default installation directory is
C:\Program Files\IBM\MasterConsole.

Click Finish to complete the installation

If a system reboot is required, accept the prompt to complete the master
console installation process.

Mirroring the boot drive

This topic describes how to mirror the boot drive on the master console using the
Windows software mirroring capability.

If the target disk has a partition assigned to it (that is, it already has a drive letter),
free the disk by right-clicking My Computer then selecting Manage->Storage-
>Disk Management then right-click the target disk drive and select Delete
Partition.

Perform the following steps to mirror the boot drive:

1.

2.
3.
4.

From the desktop, right-click My Computer.
Click Manage.

Click Storage » Disk Management .
Right-click the disk icon for the system disk.
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5. Click Upgrade to dynamic disk and then click OK.

6. Right-click the disk icon for the disk that you want to become the mirror of
the system disk.

7. Click Upgrade to dynamic disk and then click OK.

Note:
* If you receive a warning, click Yes.
* If your system reboots, restart the Disk Management.
8. Right-click the disk icon for the system disk.
9. Click Add Mirror.

10. Select the disk that you want to become the mirror of the system disk, and
then click Add Mirror.

11. A warning dialogue box appears stating that you must update the boot.ini file.
Click OK to continue.

12. Update the boot.ini file:
a. From the desktop, double-click My Computer.
b. Click Tools » Folder options.
c. Click the View tab.
d

. In the Advanced settings list, select the Show hidden files and folders
radio button.

©

In the My Computer window, click Local disk (C:).

—n

. Double-click the c:\boot.ini file to open the file in Notepad.

Attention: Be cautious when editing this file to make only the requested
changes. Do not modify any other lines in this file.

g. In the operating system section, add Primary to the end of the operating
description for the system disk.

h. Copy the line for the system disk, and change Primary to Secondary, and
change the system disk (for example, disk(0)) to mirrored disk (for
example, disk(1)). The file should look similar to the following example:

[boot Toader] timeout=30 default=multi(0)disk(0)partition(1)\WINNT [operating
system] multi(0)disk(0)partition(1l)\WINNT="Microsoft Windows 2000 Advanced
Server Primary" /fastdetect
multi(0)disk(1)partition(1)\WINNT="Microsoft Windows 2000 Advanced
Server Secondary" /fastdetect

i. Save and close the file.
j- Reboot the machine.

K. After the machine completes the POST test, the system prompts you to
select the Microsoft Windows operating system to boot from. Select
Microsoft Windows 2000 Advanced Server Secondary and press Enter to
verify that the machine boots successfully from the mirrored drive.

I. Reboot the machine again.

m. After the machine completes the POST test, the system prompts you to
select the Microsoft Windows operating system to boot from. Select
Microsoft Windows 2000 Advanced Server Primary and press Enter to
verify that the machine boots successfully from the system drive.
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Chapter 5. Configuring the master console

This topic provides an overview of the steps for configuring the master console.

Perform the following steps to configure the master console. Details for these steps
are given in the sections that follow this list.

Note: For San Volume Controller users: As mentioned in |[Chapter 1, “Overview,” on|
you need to install and configure the master console before
configuring the SAN Volume Controller. Similarly, you need to configure a
cluster using the SAN Volume Controller Console before completing steps
B E El, and [9} In addition to those steps, you will need to set up Virtual
Network Computing (VNC) to enable the full remote support service, as
described in the SAN Volume Controller Configuration Guide.

Log onto the master console.
Generate an SSH key pair using PuTTY.
Configure the PuTTY session (for command-line access).

Howb -

If you are using the master console with the SAN File System, you can choose
to use secure SSH. If you do, you need to:

a. Make sure each of the metadata servers in the SAN File System cluster are
running.

b. Copy the master console SSH public key file onto each of the metadata
server engines.

5. If you are using the master console with the SAN Volume Controller:
a. Start the SAN Volume Controller Console for the SAN Volume Controller.

b. Store the master console SSH public key file on each SAN Volume
Controller cluster.

c. Set up a new zone on the Fibre Channel Switches that includes the master
console and all of the 2145 nodes.

Configure and start Tivoli SAN Manager.
Configure service alert.

Start IBM Director.

Modify your IBM Director settings.

© ©o N

Configuring a default PUTTY session

This topic explains how to configure a default PuTTY session so that you can run
SSH from a command-line interface.

You only need to perform these steps if you are planning to run the PuTTY from a
command prompt window and you are using private and public keys.

Remember: Keys are required for SAN Volume Controller, but they are not
required for SAN File System.

Perform these steps to configure the PuTTY session on the master console:

1. Click Start —>Programs —> PuTTY —> PuTTY to open the PuTTY
Configuration GUI window.

2. In the categories pane, make sure that Session is selected.
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8.
9.
10.

Select SSH as the protocol under the PuTTY basic options.
In the categories pane, click Connection —> SSH.

Select 2 as the preferred SSH protocol version.

In the categories pane, click Auth.

Type the fully-qualified file name of the SSH client private key file you
specified when you used the PuTTY Key Generator in the Private key file for
authentication field in the Authentication Parameters. For example,
C:\Support Utils\PuTTY\icat.ppk.

If you do not know the file name, you can click Browse to select the file name
from the system directory.

In the categories pane, click Session.
In the Saved Sessions window, click Default Settings.
Click Save to save your settings.

Storing keys in the SAN Volume Controller console software

This

topic describes how to store your SSH keys in the SAN Volume Controller

Console software. When the keys that are used to communicate with the SAN
Volume Controller are changed, you must store a copy of the new private key in
the SAN Volume Controller Console software.

Perform the following steps to store a copy of the new private key in the SAN
Volume Controller Console software:

1. Open a command prompt window by clicking Start —>Run.
2. Type cmd.exe in the Open box. Click OK.
3. Type the following command:

copy path\filename C:\"Program Files"\IBM\svcconsole\cimom\icat.ppk

where path\filename is the path and file name where you stored the SSH private

k

ey when it was generated in the previous procedure.

Note: Directory names with embedded spaces must be surrounded by

quotation marks.

4. Stop and start the IBM CIM Object Manager to make the change take effect.
Perform the following:

a.
b
c.
d

e.

Click Start —>Settings —> Control Panel.
. Double-click Administrative Tools.
Double-click Services.

. From the list of services, right-click IBM CIM Object Manager. Select Stop
and wait for Windows to stop the service

From the list of services, right-click IBM CIM Object Manager. Select Start.

Setting up service

This
Cont

alert for SAN Volume Controller

topic provides an overview of configuring service alerts for SAN Volume
roller.

Before performing these procedures:

* SAN Volume Controller must be installed and configured.

* You need to know the serial number of the SAN Volume Controller.
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You can configure IBM Director to alert your system administrator through e-mail
when errors or events are logged by the SAN Volume Controller and you can
choose to initiate a call-home to IBM when failures that require service actions are
logged by the SAN Volume Controller.

Setting up e-mail notification
This task provides step-by-step instructions for configuring IBM Director to alert

your system administrator via e-mail when errors or events are logged by the SAN
Volume Controller.

Perform the following steps to configure IBM Director to notify your system
administrator of SVC errors and events:

1.

Cause a temporary error on the SAN Volume Controller to force an SNMP
trap to be sent to the master console IP address. For example, temporarily
remove one of the SAN Volume Controller fibre channel cables, which will
cause error code 1060 to be displayed on the front panel of the SAN Volume
Controller node. After this error is displayed, replace the fibre channel cable,
and delete the entry in the SAN Volume Controller error log.

Logon to the master console.

From the desktop, double-click the IBM Director console icon to open the

IBM Director console.

Log on to the IBM Director console.

Validate that IBM Director received the traps sent by SAN Volume Controller

with these steps:
a. Double click the Event Log in the right column of IBM Director console.
b. Verify that the SNMP traps were received. SAN Volume Controller traps
can be identified by displaying the Event Type field of the log. For SAN
Volume Controller traps, the field will contain text starting with
SNMPiso.org.dod.internet.private.enterprises.ibm.ibmProd.190. If the traps were
not received:
¢ Contact your network administrator to ensure that there was not a
networking problem.

* Verify that the error notification setting on the SAN Volume Controller is
not set to none.

* Verify that the master console IP address has been configured.

c. Close the Event Log.

From the IBM Director main panel, click Task+Event Action Plan Builder. The
Event Action Plan Builder panel opens.

Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of
the Event Action Plan Builder panel.

Double click 2145EventNot.
Enter the following information in the displayed form:

a. Internet E-mail Address Enter an e-mail address (for example, the e-mail
address of the system administrator).

b. Reply to Enter the e-mail address to which you want replies to be
directed.

c. SMTP E-mail server Enter the name or IP address of the SMTP mail
server.

d. SMTP port Enter the port number through which e-mail is sent to your
e-mail server. The default is 25.
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10.
11.
12.

e. Subject of E-mail Message Enter the following text: 2145 Event
Notification.

f. Body of E-mail Message Enter any information that you want to be sent to
the recipient of the e-mail (for example, machine location information). The
body of the e-mail will also contain all the SNMP trap data containing the
details of the event.

Click File->Save.
Close the Event Action Plan Builder panel.
Close the main IBM Director panel.

Configuring service alert for SAN Volume Controller

This task provides step-by-step instructions for configuring IBM Director for the
SAN Volume Controller error notification and service alert (the Call Home feature).

Perform the following steps to configure the master console to support the Call
Home feature:

1.
2.

©

Log on to the master console.

From the desktop, double-click the IBM Director console icon to open the
IBM Director console.

Log on to the IBM Director console.

From the IBM Director main panel, click Task+Event Action Plan Builder. The
Event Action Plan Builder panel opens.

Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of

the Event Action Plan Builder panel.

Double click 2145CallHome

Enter the following information in the displayed form:

a. Internet E-mail Address If the SAN Volume Controller is located in North
America, Latin America, South America or the Caribbean Islands, enter
callhomel@de.ibm.com. If the SAN Volume Controller is located anywhere
else in the world, enter callhome0O@de.ibm.com.

b. Reply to Enter the e-mail address to which you want replies to be
directed.

C. SMTP E-mail server Enter the name or IP address of the SMTP mail
server.

d. SMTP port Enter the port number through which e-mail is sent to your
e-mail server. The default is 25.

e. Subject of E-mail Message Enter the following text: 2145 Event
Notification.

f. Body of E-mail Message Complete the following text fields replacing the
text shown in italics. Do not change any other fields in the body of the
e-mail message:

* # Contact name = contact_name (maximum 72 characters)
» # Contact phone number = telephone_number (maximum 72 characters)
* # Offshift phone number = telephone_number (maximum 72 characters)
e # Machine location = machine_location (maximum 72 characters)

Click File->Save

Double click 2145Test

Enter the information in the displayed form that you entered in step ﬁ with
this additional text field to be completed in the Body of E-mail Message

* # Serial Number = serial number of any installed SAN Volume Controller
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11. Click File->Save
12. Close the Event Action Plan Builder panel.
13. Close the main IBM Director panel.

Note that action Plan data is preconfigured. If this data becomes corrupted, the
Call Home function and event notifications will fail. To recover Action Plan
preconfiguration data that has been damaged, visit
www.ibm.com/storage/support/2145/ and locate the details for recovering
corrupted call-home preconfiguration data.

Setting up service alert for SAN File System

This topic provides an overview of configuring service alerts for SAN File System.

The Service Alert feature works as follows:
1. The SAN File System raises an SNMP trap as the result of a detected error.
2. IBM Director on the master console receives notification of the trap.

3. IBM Director collects the trap and sends a specifically formatted e-mail to the
specified system administrator.

Note: When an alert is sent by SAN File System, the system administrator may
contact IBM Support Center if assistance is needed.

To configure service alerts, you need to compile the MIBs for the SAN File System
and the RSA II adapter, and you also need to configure Service Alerts. You can also
setup up e-mail notification.

Compiling MIBs for the SAN File System

This topic describes how to compile MIBs for the SAN File System on the master
console.

The SAN File System cluster must be installed and operational and the metadata
server must have been configured to send traps to the master console.

You need to compile MIBs for the SAN File System Service Alert feature and for
the RSA II adapter.

Perform the following steps to compile the Service Alert MIB.

1. Use secure copy to copy the MIB from the metadata server to the master
console:

a. Open a DOS command prompt on the master console.

b. Change to the putty directory (cd /program files/putty) and run pscp to
copy a file from a metadata server engine. Note that you enter the
command on one line and that target_file needs to end in the extension .mib.

pscp -1 private_key_file -2 userID@engine_IP_address:
/usr/share/snmp/mibs/IBM-SANFS-MIB.txt target file.mib

If private keys have not been exchanged with the metadata servers, use the
following syntax:

pscp.exe -2 userID@engine_IP_address:
/usr/share/snmp/mibs/IBM-SANFS-MIB.txt target file.mib

2. Open the IBM Director console.
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Note: When you log in to IBM Director, the password for the IBM Director
Login window must match the password for the IBM Director Server
services.

3. In the Tasks menu, click Discover Systems and then SNMP Devices.

4. In the Groups pane on the left side of the panel, expand the All Groups group
and right-click the SNMP Devices group, then click Compile a new MIB.

5. When the window opens, asking you to select the location of the new MIB,
click the IBM-SANFS-MIB.txt file that you have saved.

6. The Status Messages window presents the following:

MIB file submitted to the server.
Starting MIB compile...

MIB Parsing complete

Resolving MIB imports

Saving MIB objects...

MIB Compile Finished.

7. Close the Status Messages window.
8. Compile the MIB for the RSA II adapter to configure it to send traps as well.

a. Download the RSA MIB. The MIB is obtained from the IBM Support Web
site at http://www.ibm.com/pc/support as part of the firmware package
for the RSA II adapter. You download the firmware update from IBM as a
single executable file.

b. Run the executable file, which will request that you insert a diskette. The
diskette is formatted and the updated software is copied to the diskette
(including the MIB).

c. Use the same process for compiling the RSA MIB as for the SAN File

System MIB. For more information, refer to the RSA II firmware
documentation.

Configuring service alert for SAN File System

This task provides instructions for configuring IBM Director for the SAN File
System error notification and service alert.

The SAN File System management information base (MIB) must have been
compiled on the master console. In addition, the SAN File System cluster must be
installed and operational, and the metadata servers must have been configured to
send traps to the master console. See the SAN File System Installation and
Configuration Guide for information about configuring SNMP traps on metadata
server engines.

Perform the following steps to configure the master console to support the Service
Alert feature:

1. Verify that the metadata servers can send Simple Network Management
Protocol (SNMP) traps to the master console. From the master metadata
server, run the following snmptrap commands. Note that the quote marks are
two single quotes:
snmptrap -v 2c -c public master_console_IP_address '' SNMPv2-MIB:coldStart

snmptrap -v 2c -c public master_console_IP address '' IBM-SANFS-MIB:sanfsGenericTrap

where master_console_IP_address is the IP address or host name of the master
console.

2. Log on to the master console.
3. From the desktop double-click the IBM Director console icon to open the IBM
Director console.
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10.

11.

Log on to the IBM Director console.

Validate that IBM Director received the traps sent by the SAN File System
master metadata server.

a. Double-click Event Log in the right column of the IBM Director console.

b. Verify that the SNMP traps were received. Look for the metadata server
hostname or IP address under the Sender Name column. If the traps were
not received:

* Contact your network administrator to ensure that there was not a
networking problem.

* Make sure that the SAN File System sent the traps.
c. Close the event log.
From the IBM Director main panel, click Tasks.

In the Tasks menu, click Event Action Plan Builder. The Event Action Plan
Builder window opens.

From the Event Action Plan Builder window, right-click Simple Event Filter
and click New.

A new simple event filter builder window opens. Perform the following steps:
a. In the Event Type tab, make sure that the Any option is not checked.
b. Expand the tree in the Event Type tab to select the following:

SNMP.iso.org.dod.internet.private.enterprises.ibm.ibmProd.
ibmSanfsModule.ibmSanfsTraps

c. Click File, and then click Save as.
d. Enter tankGenericTrap and the name of the event filter and click OK.

Right-click Send an Internet (SMTP) E-mail in the right column of the Event

Action Plan Builder menu and click Customize.

Enter the following information in the displayed form:

* Internet E-mail address. Fill in an e-mail address to which to send service
notifications (for example, the e-mail address of the system administrator).

* Reply to. Fill in an e-mail address to which to send service notifications (for
example, the e-mail address of the system administrator).

* SMTP e-mail server. Enter the name or IP address of the SMTP mail server.

¢ SMTP port. Enter the port number through which e-mail is sent on your
e-mail server. The default is 25.

* Subject of E-mail Message — Enter the following text: IBM SAN FS
Call-home Notification.

* Body of E-mail message — Enter the following text as shown.

#Machine type=machine_type

#Device serial number=serial_number
#Record type=1

#Component id=software

#Contact name=contact_name

#Contact phone=telephone_number
#Mgmt node=&system

#Date recvd=&date

#Time recvd=&time

where:

* Machine_type is a four-digit device type and three-digit model.

* Serial_number is the serial number of the master engine in the cluster.
* The contact_name and telephone_number can be any length and format.
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12.
13.

14.

15.

16.

17.
18.

19.

20.
21.

22.
23.

¢ The values &system, &date, and &time are entered exactly as shown. They
are not variables.

Note: E-mails will include the text of the service alert message.
Click File, and then click Save As.

Enter IBM SAN FS Call-home Notification as the name of the e-mail action,
and then click OK.

Expand the Event Action Plan » Log All Events hierarchy in the left column
of the Event Action Plan window.

Expand the Simple Event Filter hierarchy in the middle column of the Event
Action Plan Builder window.

Drag the tankGenericTrap event filter from the middle column to Log All
Events in the left column.

Click Yes in response to any warning pop-up windows that open.

Expand the Send an Internet (SMTP) E-mail hierarchy in the right column of
the Event Action Plan Builder menu.

Drag the IBM SAN FS Call-home Notification item from the Send an
Internet (SMTP) E-mail hierarchy to the tankGenerictrap item in the left
column.

Click Yes in response to any warning pop-up windows that open.
Optionally, enable the action history, which will show a history of all events.
a. Right-click the action plan that you just created.

b. Click Action History.

c. Click Enable.

Close the Event Action Builder window.

Close the IBM Director window.

Setting up e-mail notification
This task provides step-by-step instructions about setting up your e-mail
notification for the SAN File System.

Perform the following steps to set up your e-mail notification:
Start IBM Director by clicking the IBM Director Console icon on the desktop.

From the IBM Director Console menu bar, select Tasks —> Event Action Plan
Builder.

In the Actions column, expand the item Send an Internet (SMTP) E-mail.

Right-click IBM SAN FS Call-home Notification and select Update. The
Customize Action: IBM SAN FS Call-home Notification panel displays.

Fill in the following items:

1.
2.

6.

Internet E-mail Address — Fill in an e-mail address (for example, the e-mail
address of the system administrator)

Reply to — Fill in the e-mail address to which you want any replies to be
directed.

SMTP E-mail Server — Fill in the address of your e-mail server.

SMTP Port — Change this, if required, to your SMTP server port number.
Subject of E-mail Message — Fill in SAN File System Event Notification.
Body of E-mail message — Enter the following text as shown.

# Machine location = Data Centre

Click File —> Save to save the information.

38  Master Console Installation and User’s Guide



7. Close the Event Action Plan Builder window.
8. Close the IBM Director Console window.
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Chapter 6. Managing the master console

This topic provides an overview of the tasks that you can perform from the master
console.

Tasks that you can perform from the master console include:

Starting Tivoli SAN Manager.

Accessing SAN File System.

Initiating remote support.

Replacing the SSH key pair for SAN Volume Controller.

Replacing the client SSH private key known to the SAN Volume Controller
software.

Setting passwords for Tivoli SAN Manager, DB2, and SAN Volume Controller.

Starting Tivoli SAN Manager

This task provides step-by-step instructions about how to start the Tivoli SAN
Manager. Ensure that you configure the Tivoli SAN Manager to meet your
requirements.

Perform the following steps to start Tivoli SAN Manager:

1.

A

© Copyright IBM Corp. 2004,

Double-click Tivoli NetView icon on your desktop, or select Start » Programs »
Tivoli Console.

On the menu bar, select SAN » Configuration.

Click Configuration Manager.

Select Switches and Other SNMP Agents > SNMP Agents .

Add the IP address for each Fibre Channel switch into the SNMP Agents list:
a. Click Add.

b. Type the IP address or name of the Fibre Channel switch and click OK.

c. In the SNMP Agents section of the Switches and Other SNMP Agents panel,
select the entry for the Fibre Channel switch and click Advanced.

d. Type the user ID and password for that particular switch (the
manufacturing defaults for user ID is admin and password is passwOrd).
This enables Tivoli SAN Manager to access the switch to collect zoning
information.

e. To enable this access, configure the Fibre Channel switch to allow SNMP
Command Access. Refer to your Fibre Channel switch documentation for
procedures on setting up this access.

Verify the installation by running a SAN discovery. From the menu bar, click

SAN -~ Configure Manager. This displays the Configure Manager panel

Select Clear History » OK.
Select Cancel on the Configure Manager panel.

Ensure that the Tivoli SAN Manager discovers all expected Fibre Channel
connections and devices. You can visually check that the Tivoli SAN Manager
discovers all expected connections and device by displaying the topology map
for each fabric and seeing that all the expected devices are presented.
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Accessing the SAN File System

This topic describes how to access the SAN File System metadata server engines
through an SSH session.

From the master console, you can access the metadata server engines in the SAN
File System cluster using PuTTY to establish an SSH session. For more information
about PuTTY, refer to the PuTTY user’s manual.

Accessing the SAN File System from the command line

This topic describes how to access the SAN File System metadata server engines
through an SSH session from the command line.

Perform these steps to establish an SSH session to any of the engines in the SAN
File System from the command line.

1. Open a DOS command prompt on the master console.

2. Change to the PuTTY directory.
cd \Program Files\PuTTY

3. Run putty to establish an SSH session with a master metadata server engine.
putty.exe —ssh engine IP address -1 private key file -2

Note: If you are not using private/public keys with the SAN File System, omit
the -I and -2 parameters.

4. Log in to the master metadata server engine using a Linux" user ID and
password.

After connecting to the engine, you can access the SAN File System administrative
command-line interface (CLI) to run SAN File System commands. These
commands provide the ability to manage engines, metadata servers, and
administrative servers.

In addition, you can perform operating system commands from the SSH session as
well.

Accessing the SAN File System from the desktop

This topic describes how to access the SAN File System metadata server engines
through an SSH session from the master console desktop.

Perform these steps to establish an SSH session to any of the engines in the SAN
File System from the master console desktop.

Note: If you are using secure keys, make sure that you have configured SSH to
use those secure keys.

Double-click the PuTTY icon.

Fill in the IP address of the engine to be accessed.
Select SSH as the protocol.

Click Open.

After the session is established, log in using a Linux user ID and password.

ok wn =
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After connecting to the engine, you can access the SAN File System administrative
command-line interface (CLI) to run SAN File System commands. These
commands provide the ability to manage engines, metadata servers, and
administrative servers.

In addition, you can perform operating system commands from the SSH session as
well.

Transferring files using pscp

This topic describes how to use the PuTTY secure copy function to copy files from
a metadata server engine and the master console.

Perform these steps to transfer files from a metadata server engine in the SAN File
System cluster to the master console using secure copy. For more information
about pscp, refer to the PuTTY user’s manual.

1. Open a DOS command prompt on the master console.

2. Run pscp to copy a file from a metadata server engine.

pscp.exe userID@engine_IP_address:source_file target_file -1 private_key_file
-2

Transferring files using psftp

This topic describes how to use the PuTTY ftp function to transfer files between a
metadata server engine and the master console.

Perform these steps to transfer files between a metadata server engine in the SAN
File System cluster and the master console using ftp. For more information about
psftp, refer to the PuTTY user’s manual..

1. Open a DOS command prompt on the master console.

2. Start the psftp session.
psftp

3. Open a connection to the metadata server engine.
open userID@engine_IP_address

4. Change to the appropriate directory on the metadata server (for example, cd
/path).

5. Change directories to the appropriate directory on the master console (for
example, led /path).

6. Use put to transfer files to the metadata server engine and get to retrieve files
from the metadata server engine.

put file_name new_file_name
or
get file_name new_file_name

7. End the ftp session by entering quit.

Initiating remote support

This topic provides an overview about initiating remote support.
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When IBM is trying to provide a solution to a particular problem, you might be
requested to invoke an IP connection so that a remotely based service
representative can interrogate the master console to collect additional information
on the problem.

Perform the following steps to initiate remote support:
1. Invoke the remote support connection.
2. Add an additional subnet route.

Invoking a remote support connection

This topic describes how to invoke a remote support connection.

Note: To ensure that the IBM Support Center has the correct access to the master
console and its various software packages, it might be necessary to provide
passwords, including the Administrator password, or to be present to input
the passwords when required.

Perform the following steps to set up a secure connection to IBM with Connection
Manager:

1. Double-click the IBM Connection Manager icon in the Master Console folder
on the desktop to display the Connection Manager window.

2. Choose IBMVPN from the destination drop-down menu.

3. Click Make Connection when you are ready for the IBM remote service
representative to log in. The status “Disconnected” at the bottom of the
window changes to “Connected.”

4. Click Generate Connection ID. An alphanumerical string displays in the box to
the right of the Generate Connection ID button. This is your connection ID; it
must be given to the IBM remote service representative.

5. After all remote support actions are complete, click Disconnect to terminate the
connection.

6. When prompted to confirm the connection termination, click OK. The status
“Connected” at the bottom of the window changes back to “Disconnected.”

7. To close down the application, click Cancel, and then click OK.

Adding an additional subnet route

This topic describes how to add a new route for the IBM support network after the
VPN connection has been established using the IBM Connection Manager.

Perform the following steps to add an additional subnet route.
1. Determine the support network IP address of the master console:
a. Click Start —> Programs —> Accessories —> Command Prompt.

b. Enter ipconfig /all. The end of the listing will look similar to the following
example:

PPP adapter IBMVPN:

Connection-specific DNS Suffix

Description . . . . . . . . . . . : WAN (PPP/SLIP) Interface
Physical Address. . . . . . . . . : 00-53-45-00-00-00

DHCP Enabled. . . . . . . . . . . : No

IP Address. . . . . . . . . . . . : 198.74.64.60

Subnet Mask . . . . . . . . . . . : 255.255.255.255

Default Gateway . . . . . . . . . :
DNS Servers . . . . . . . . . ..
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2. Determine the support network interface number (IF) by entering route print.
The beginning of the routing table will look similar to the following example:

OXl vt i i i i i MS TCP Loopback interface

0x1000003 ...00 02 55 7b Oc 09 ...... Intel(R) 82546EB Based Dual Port
Network Connection

0x1000004 ...00 02 55 7b Oc 08 ...... Intel(R) PRO/1000 MT Dual Port
Network Connection

0x2000004 ...00 53 45 00 00 00 ...... WAN (PPP/SLIP) Interface

The support network interface is identified as the WAN (PPP/SLIP) Interface.
The number given is in hex and must be converted to decimal (for example,
0x2000004 (hex) = 33554436 (decimal)).

3. Add the new route for the support network by entering the following
command:

route ADD 198.74.64.0 MASK 255.255.252.0 [remote_support_IP]
IF [IF_decimal_number] Metric 2

Where remote_support_IP is the master console IP address determined in step
and IF_decimal_number is the interface number determined in step [
(for example, route ADD 198.74.64.0 MASK 255.255.252.0 168.74.64.60 IF
33554436 Metric 2).

4. Verify that the new route was added by entering route print and finding the
198.74.64.0 255.255.252.0 entry in the table. The output will look similar to the
following:

OX] v i e e MS TCP Loopback interface

0x1000003 ...00 02 55 7b Oc 09 ...... Intel(R) 82546EB Based Dual Port
Network Connection

0x1000004 ...00 02 55 7b Oc 08 ...... Inte1(R) PRO/1000 MT Dual Port Network

Connection
.WAN (PPP/SLIP) Interface

Active Routes:

Network Destination Netmask Gateway Interface Metric
0.0.0.0 0.0.0.0 9.47.101.1 9.47.101.159 1
0.0.0.0 0.0.0.0 9.47.101.1 192.168.70.105 1
9.47.101.0 255.255.255.0 9.47.101.159 9.47.101.159 1
9.47.101.159 255.255.255.255 127.0.0.1 127.0.0.1 1
9.255.255.255 255.255.255.255 9.47.101.159 9.47.101.159 1
127.0.0.0 255.0.0.0 127.0.0.1 127.0.0.1 1
192.168.0.0 255.255.0.0 192.168.70.105 192.168.70.105 1
192.168.70.105 255.255.255.255 127.0.0.1 127.0.0.1 1
192.168.70.255 255.255.255.255 192.168.70.105 192.168.70.105 1
198.74.64.0 255.255.252.0 168.74.64.60 198.74.64.60 2
198.74.64.0 255.255.255.0 198.74.64.60 198.74.64.60 1
224.0.0.0 224.0.0.0 9.47.101.159 9.47.101.159 1
224.0.0.0 224.0.0.0 192.168.70.105 192.168.70.105 1
255.255.255.255 255.255.255.255 9.47.101.159 9.47.101.159 1
Default Gateway 9.47.101.1

Persistent Routes:

None

5. Verify routing to the support network by entering ping 198.74.67.235.
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Replacing the SSH key pair for SAN Volume Controller

This topic provides step-by-step instructions for replacing the SSH key pair.

Note:

* If you change the SSH keys that will be used by the master console to
communicate with the SAN Volume Controller Console you will have to
store the client SSH private key in the SAN Volume Controller Console
software as described previously and then store the client SSH public key
on the SAN Volume Controller cluster.

* If you change the IP address of your SAN Volume Controller cluster after
you have added the cluster to SAN Volume Controller Console, the SAN
Volume Controller Console will not be aware of the existence of the
cluster.

To correct this, remove the cluster from the SAN Volume Controller Console and
add it back again. Perform the following steps:

1.

Start the SAN Volume Controller Console by clicking on the desktop icon or
by using your Web browser to go to http://IP_address:9080/ica, where
IP_address is the IP address of the master console. The Signon window is
displayed. This might take a few moments to open.

Enter the user ID superuser and the password passwOrd. The Welcome
window is displayed.

Click Clusters from the portfolio.

Check the Select box for the cluster for which you wish to replace the key.
Click Remove a cluster in the selection box

Click Go.

Click Clusters from the portfolio.

Click Add a cluster in the selection box.

Input the IP address of the cluster.

Do not check the Create (Initialize Cluster) box.

. Click OK.

Enter the user name and password. When you see the pop-up window, enter
the network password and click OK.

Add the SSH client public key to the SAN Volume Controller cluster:

a. Click Browse... for the key file to upload and locate the public key or
input the key in the Key (direct input) field

b. Type an identifier in the ID field, which uniquely identifies the key to the
cluster.

C. Select the Administrator radio button.

d. Click Add Key.

e. Click Clusters from the portfolio to check the status of the cluster. If the
cluster status remains SSH Key Refused, you do not have a good key
pair. You can reset the SAN Volume Controller Console private SSH key.
However, if you have successfully contacted other clusters, you will break
that connectivity.
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Replacing the client SSH private key known to the SAN Volume
Controller software

This task provides step-by-step instructions to replace the client SSH private key
known to the SAN Volume Controller software.

Attention: If you have successfully contacted other SAN Volume Controller
clusters, you will break that connectivity if you replace the client SSH private key
known to the SAN Volume Controller software.

Perform the following steps to replace the client SSH private key:
1. Sign off the SAN Volume Controller Console.
2. Using the Windows Services facility, stop the IBM CIM Object Manager:
a. Click Start —> Settings —> Control Panel.
b. Double-click Administrative Tools.
c. Double-click Services.
d

. Select IBM CIM Object Manager in the list of services, right click, and
select Stop.

e. Leave the Services panel open.

3. Copy the client SSH private key into the appropriate SAN Volume Controller
Console directory. Perform the following;:

a. Open a command prompt window by clicking Start —> Run.
b. Type cmd.exe in the Open field.
c. Click OK.

4. Type the following command:

copy filename C:\program files\IBM\svcconsole\cimom\icat.ppk
where filename is the path and file name of the client SSH private key

5. Restart the IBM CIM Object Manager. Select IBM CIM Object Manager in the
list of services, right click and select Start.

6. Log on to the SAN Volume Controller Console.
7. Click Clusters in the portfolio.
8. Check the status of the cluster.

Setting passwords

This topic lists the passwords that you must set on the master console.

The following passwords must be set on the master console:
* Tivoli SAN Manager (changing the Host Authorization)

* DB2 user IDs and passwords

* SAN Volume Controller user ID and password

Changing the Host Authorization for Tivoli SAN Manager
password

This topic describes how to set the Host Authorization for Tivoli SAN Manager
password on the master console.
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Note: Verify that the file C:\Support Utils\ChangeWASAdminPass.bat is present.
If not, download it into the C:\Support Utils directory from the 2145
Support Web site, by selecting Downloadable files from the following URL:
[www.ibm.com /storage/support /2145

These IDs and passwords are used internally by the master console, and can be
changed if required.

You can change this password by performing the following steps:

1. Open a command prompt window by selecting Start —> Programs —>
Accessories —> Command Prompt.

2. Type cd C:\Support Utils.
3. Type ChangeWASAdminPass new_user_ID new_password.
4. Reboot the master console.

Setting the DB2 user IDs and passwords

This topic describes how to set the DB2 user IDs and passwords on the master
console.

You can change the DB2 user IDs and passwords by performing the following
steps:

1. Use the Computer Management Administrative tool to change the password for
the Base User ID password (db2admin):
a. Select Start —> Settings —> Control Panel.

b. Double-click Administrative Tools —> Computer Management —> Local
Users and Groups from the left-hand navigation.

2. Use the Computer Management Administrative tool to change the database
password used by Tivoli SAN Manager. If it is changed, you must perform the
following steps:

a. Open a command line window by selecting Start —> Programs —>
Accessories —> Command Prompt.

b. Enter cd c:\tivoli\itsanm\manager\bin\w32-ix86.

c. Enter srmcp -u userID -p password ConfigService setAuthenticationPw
newPassword where userID is your user ID, password is your password, and
newPassword is the new host authentication password.

Setting SAN Volume Controller user ID and password

This topic describes how to set the SAN Volume Controller user ID and password
on the master console.

These are set using the SAN Volume Controller Web pages accessed using a Web
browser or using the SAN Volume Controller Console function. See the SAN
Volume Controller documentation for more information about changing the ID and
password.
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Chapter 7. Uninstalling master console software

This topic provides a high-level overview of the procedures for uninstalling the
master console software.

To remove the master console software, you must explicitly remove each of the

software packages using the Add or Remove Programs dialog panel. Because of
product dependencies, you must remove the software packages in the following
order:

IBM Director

Tivoli SAN Manager Agent

Tivoli SAN Manager

DS4000 Storage Manager Client (FAStT Storage Manager Client)

SAN Volume Controller Console

DB2

PuTTY

Adobe Acrobat Reader

Master Console

CONOOAWND =

Note: When you remove the master console, you remove documentation,
support utilities, and icons. Therefore, you can continue to access all
product documentation until you remove the master console. The
documentation is located in <destination_location>\Documents, where
<destination_location> is the location where the master console was
installed on the system. The default location is system_drive\Program
Files\IBM\MasterConsole.

Accessing the Add or Remove Programs dialog panel

Perform the following steps to access the Add or Remove Programs dialog panel:
1. From the Windows menu bar, click Start->Settings->Control Panel.
2. From the Control Panel window, double-click the Add/Remove Programs icon.

Uninstalling IBM Director

This topic describes how to uninstall IBM Director from the master console using
the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall IBM Director:

1. In the Add/Remove Programs panel, scroll to IBM Director, and click to select
it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.
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Uninstalling Tivoli SAN Manager Agent

This topic describes how to uninstall Tivoli SAN Manager Agent from the master
console using the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the Tivoli SAN Manager Agent:

1. In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area
Network Manager - Agent, and click to select it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling Tivoli SAN Manager

This topic describes how to uninstall Tivoli SAN Manager from the master console
using the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the Tivoli SAN Manager:

1. In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area
Network Manager - Manager, and click to select it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling the DS4000 Storage Manager Client (FAStT Storage
Manager Client)
This topic describes how to uninstall the DS4000 Storage Manager Client (FAStT

Storage Manager Client) from the master console using the Add/Remove Programs
dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the DS4000 Storage Manager Client (FAStT
Storage Manager Client):

1. In the Add/Remove Programs panel, scroll to the product name, and click to
select it.

2. Click Change/Remove.
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Navigate through the uninstallation wizard, selecting the Next button of each
window.

Wait for the program to be removed, and then click Finish

If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling the SAN Volume Controller Console

This topic describes how to uninstall the SAN Volume Controller Console from the
master console using the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the SAN Volume Controller Console:

1.

In the Add/Remove Programs panel, scroll to IBM TotalStorage SAN Volume
Controller Console, and click to select it.

Click Change/Remove.

Navigate through the uninstallation wizard, selecting the Next button of each
window.

Wait for the program to be removed, and then click Finish

If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling DB2

This topic describes how to uninstall DB2 from the master console using the
Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall DB2:

1.
2.
3.

4.
5.

In the Add/Remove Programs panel, scroll to IBM DB2, and click to select it.
Click Change/Remove.

Navigate through the uninstallation wizard, selecting the Next button of each
window.

Wait for the program to be removed, and then click Finish

If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

After removing DB2, you must also remove the following directories:

The directory where DB2 was installed. The default directory is
system_drive\Program Files\SQLLIB.

The DB2 directory that contains database data,. The default directory is
system_drive\DB2.

The DB2log directory containing the DB2 log files. The default directory is
system_drive\DB2.
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Uninstalling PuTTY

This topic describes how to uninstall PuTTY from the master console using the
Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall PuTTY:
1. In the Add/Remove Programs panel, scroll to PuTTY, and click to select it.
2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

Uninstalling Adobe Acrobat

This topic describes how to uninstall Adobe Acrobat from the master console using
the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall PuTTY:
1. In the Add/Remove Programs panel, scroll to PuTTY, and click to select it.
2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

Uninstalling the master console

This topic describes how to uninstall the master console using the Add/Remove
Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the master console:

1. In the Add/Remove Programs panel, scroll to IBM TotalStorage Master
Console for SAN File System and SAN Volume Controller, and click to select
it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

To complete the removal process, you can remove the directory where the master

console was installed. The default is system_drive\Program Files\IBM\Master
Console.
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Chapter 8. Upgrading the master console to version 3.1

This topic provides information about upgrading the master console to version 3.1.

Before you begin the following procedure to upgrade to master console version 3.1,
ensure that you have logged in with a user ID with administrative privileges.

1.
2.
3.

10.

11.

12.

13.

Insert the Master Console CD-ROM 1 in the CD-ROM drive.
Click Start » Run to open the Run dialog box.

Enter cd-rom_drive:\setup.exe, where cd-rom_drive is the letter of the drive in
which you inserted the CD, and click OK.

The following message is displayed in the DOS-prompt window:

Initializing InstallShield Wizard...
Preparing Java (tm) Virtual Machine

When prompted, select the language to be used for the installation wizard and
click OK.

The installation wizard Welcome panel is displayed. Click Next.

The installation wizard License Agreement panel is displayed. Click I accept
the terms in the license agreement, and then click Next to continue the
upgrading.

The installation wizard verifies that all software prerequisites are installed on
the system. If they are not, a pop-up opens describing the prerequisites that
are not currently installed. Click OK to stop the installation wizard, then
install the prerequisite software. After you have installed the prerequisites,
start the installation wizard again.

The installation wizard displays the version of the currently installed master
console. Click Next to continue upgrading.

If any hardware requirements are not met on your system, a panel is
displayed stating the hardware requirements that are not met and warning
about a decrease of the performance level if these requirements are not met.

If the Adobe Acrobat Reader is installed at a lower version than the required
one or is not installed on your system, the installation wizard panel
Upgrading/Installing the Adobe Acrobat Reader is displayed. Click Next to
begin the upgrading or installation of Adobe Acrobat Reader.

The installation wizard Destination panel is displayed. You can keep the old
destination location displayed on the panel or select a different location. If you
select a different location, the installation program first uninstalls the product
from the old location and then it installs the master console in the new
location that you specified.

The installation wizard stops the IBM master console information center
service. Wait for the installation program to stop this service.

The installation wizard displays the Select the information center port panel.
You can keep the old information center port value or change it by selecting
an unused port value between 1 and 65535. To see the ports that are being
used by other applications, open a Command Prompt window, and enter the
netstat -a command.

The Select the optional features panel is displayed. Select or deselect the

optional features:

¢ Install DS4000 Storage Manager Client (FAStT Storage Manager Client). If
DS4000 Storage Manager Client (FAStT Storage Manager Client) is
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deselected, a message is displayed when you click the Next button to warn
you that this feature should be deselected only when DS4000 disk drives
are not part of the current configuration.

* Install IBM TotalStorage SAN Volume Controller Console. If SAN Volume
Controller console is deselected, a message is displayed when you click the
Next button to warn you that this feature should be deselected only when
SAN Volume Controller console is not part of the current configuration.

After selecting or deselecting the optional features, click Next to display the
list of products that will be upgraded by the master console wizard.

14. The List of products panel is displayed. The installation wizard displays the
list of the products of the master console, comparing the installed product
versions with the required ones in a table with the following columns:

* Products of the master console

* Versions of the already installed products

* Required versions for the products

* Actions to be done by the master console installation wizard

The table containing the list of the products to be installed or upgraded is
saved as MasterConsoleProducts.htm in the location where the master console is
installed.

Depending on the installed version of each product, the installation wizard
determines whether to install or upgrade the product using the following
conditions:

e If the product is installed and its installed version is lower than the
required version, the product will be upgraded by launching the specific
installer of the product.

e If the product is installed at a version equal to or higher than the required
version, the product is not installed. The corresponding panels that launch
and verify the specific product installation will be skipped. For the products
with higher versions than the required ones, the installation wizard displays
a warning telling you that these products were not tested with master
console.

 If a product from the list of products to be installed or upgraded is found
to be not properly installed on the system, you are asked to continue with
the installation by trying to reinstall the product with the product-specific
installer. If this action does not succeed, you need to exit the master console
installation wizard, manually remove the product from your system, and
restart the master console installation wizard.

» For DB2, if the installed edition is not Enterprise Edition, the installation
wizard inserts *Wrong edition in the Installed Version column. You must
manually uninstall the wrong installed edition. To manually uninstall the
wrong installed edition:

a. Click Cancel to exit the master console installation wizard.

b. Manually uninstall the wrong DB2 edition.

c. After uninstalling the wrong installed edition of DB2, start the master
console installation wizard again.

From this panel, click Next to continue upgrading the products.

15. All the product upgrades are done by launching the specific installer for each
product. However, the upgrade is skipped for any product that is already
installed with the same version or a higher version than the required one. For
specific product installation instructions, see [“Using the installation wizard”|
ion page 17.

If the product-specific installer cannot manage the upgrading, then it is better
to manually uninstall the old product version and then install the new one
using the master console installer.
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Note on upgrading DS4000 Storage Manager Client

When upgrading DS4000 Storage Manager Client (FAStT Storage Manager
Client) from a version lower than version 9, the installation wizard
automatically uninstalls the old version first and then installs the new one, as
follows:

a. The DS4000 Storage Manager Client (FAStT Storage Manager Client)
uninstallation panel is displayed. Click Next to remove the old version of
the product from the system.

b. The DS4000 Storage Manager Client (FAStT Storage Manager Client)
uninstallation verification panel is displayed. Click Next to verify the
product was successfully removed from the system.

c. The DS4000 Storage Manager Client (FAStT Storage Manager Client)

installation panel is displayed. Click Next to begin installing the new

version of the product. (Follow the instructions in[“Installing the DS400d

Storage Manager Client (FAStT Storage Manager Client)” on page 23 step @

on page Zﬂ.)

d. The DS4000 Storage Manager Client (FAStT Storage Manager Client)
installation verification panel is displayed. Click Next to verify the product
was successfully installed on the system.

Before you upgrade IBM Director

Before starting the IBM Director upgrading wizard, the master console wizard

performs the following actions:

a. Stops the IBM Director services (IBM Director Server and IBM Director
Support Program).

b. Checks the Log On As property of the IBM Director Server service (the
account used to log on to IBM Director).

c. If the Log On As property is set to LocalSystem, the master console wizard
displays a message telling you to change this property value to the user
name that you intend to use for the IBM Director.

After receiving such a message, you must manually change the Log On As

property of the IBM Director Server service by following these steps:

a. Open the Services window by selecting Start -> Settings -> Control Panel
-> Administrative Tools -> Services.

b. In the Services window, select the IBM Director Server service.

c. Right-click on the selected service and select Properties to open IBM
Director Server Properties.

d. Click on the Log On tab and deselect the Local System account radio
button.

e. Select This account radio button and then enter the user ID and its
password.

f. Save the changes by clicking the Apply and then OK buttons.

You need to remember this account and password because you will be asked
for it when upgrading IBM Director and then after the upgrading when
preconfiguring IBM Director (see step . This account value is
read by the installer as the default value for the IBM Director account when
upgrading.

Note: All the individual software packages are provided on CDs with the
master console. Installation instructions for the software packages are
located in the individual software installation guides.

Upgrades to the master console software products are available at the
following Web site: [www.ibm.com /storage/support/2145/| Instructions
for downloading and installing upgraded software packages are also
available at this site.
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16. The IBM Director Superuser Account panel is displayed. You need to enter the
name and password for the IBM Director superuser to perform the
preconfiguration tasks.

17. The installation program starts the IBM Director Support Program service.
Wait for Director to start and then discover the Director-managed systems.

18. If IBM Director was never preconfigured since its installation (that is, there are
no action plans for managing specific events defined in the Director), the
installation program performs the IBM Director preconfiguration tasks. These
tasks consist of creating a set of action plans designated for managing specific
events generated by the master console system. These action plans are
imported from configuration archive files that exist on the installation
package. If one or more configuration files are not found on the installation
package, or if an error occurs while action plans are being imported, a
message is displayed warning that these action plans must be manually
created after installation is completed.

19. The upgrading of the Master Console Documentation and Support Utilities is
performed in the following steps:

a. The installation wizard uninstalls the old documentation and utilities files,
Connection Manager, Document Launcher, and information center.

b. If a system reboot is required, accept the prompt to complete the
uninstallation.

c. From the Documents and Support Utilities installation panel, click Next to
begin the installation of new documentation and utilities files.

d. If prompted to insert a different CD, insert it in the CD-ROM drive and
enter the CD-ROM drive letter in the location field. Then click OK.

e. The documentation and support utilities files are copied.

The installation wizard installs Connection Manager, loads registry info,
and creates the IBM VPN client object.

g. The installation wizard copies Eclipse files of the IBM WebSphere Help
System and installs the master console information center (copying master
console-specific documentations into the IBM WebSphere Help System).

h. The program installs the master console information center as a service.

i. After all documentation and utilities are installed, the Finish panel is

displayed.
20. Click Finish.

21. If a system reboot is required, accept the prompt to complete the master
console upgrading process.

—h

22. Review the master console installation log (mclog.txt) to ensure that all
products are properly installed. The log file is located in
<installation_directory>\logs, where <installation_directory> is the directory
where the master console was installed. The default installation directory is
C:\Program Files\IBM\MasterConsole.
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Chapter 9. Troubleshooting the master console

This topic provides information you need to troubleshoot and resolve problems
with the master console.

Recovering from a master console disk failure

This topic describes how to recover from a master console disk failure.

The hard disk drive in the master console is a mirrored pair to protect against loss
of the master console due to a disk failure. If one of these mirrored pair of disk
drives fails and needs to be replaced, perform the following steps:

1.
2.
3.

© N2 o

10.
11.

12.
13.

14.

Right-click the My Computer icon on your desktop and select Manage.
Select Disk Management. The hard drives display in the right panel.

If the failing disk drive displays, right-click the main volume of the drive and
select Break Mirror.

Shut down the master console and replace the failing disk drive using the
procedures detailed in the documentation for your master console. Ensure that
the new drive has its jumpers set the same as the drive that is being replaced.
The new drive must be the same capacity or larger than the drive being
replaced.

Note:

* It might not be obvious which of the two drives has failed. In this
case, reboot with each drive connected in turn to isolate the failed
drive.

* If the replacement drive has a boot record present, erase it prior to
use.

* If the master console fails to boot, due to not being able to find the
Boot Record, change the boot sequence in the BIOS to the other hard
drive.

Restart the master console.

Right-click the My Computer icon on your desktop and select Manage.
Select Disk Management. The hard drives display in the right panel.

If a disk drive displays in the list marked "Missing”, remove it by
right-clicking the drive and selecting Remove Disk.

If the new disk drive has a "no entry sign” displayed on it, right-click it and
select Write Signature. This removes the "no entry sign.”

Right-click the new disk drive and select Upgrade to Dynamic Disk.

Right-click the volume that you want to mirror and select Add Mirror. This
step starts the Add Mirror Wizard

Use the dialogue boxes that display to configure the second volume.

A dialogue box with reference to making changes to the boot.ini file displays.
You can safely ignore this.

The status of both volumes, the existing drive and the new drive, will change
to "Regenerating” and will, after a short period of time, start to show the
percentage of regeneration completed. When the regeneration completes, the
status should show as "Healthy.”
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Troubleshooting SAN Volume Controller console problems

This topic describes how to troubleshoot problems with the SAN Volume
Controller console on the master console.

Problem

Use this information to troubleshoot problems that you are having with SAN
Volume Controller console on the master console.

Investigation
If the SAN Volume Controller console closes unexpectedly

A dialogue box is displayed containing the words: You have signed off.
This window will be closed.

Before checking for hardware errors, open a new browser window and
attempt to reconnect to the SAN Volume Controller Console. The logoff
message is generally caused by the open session timing out (the browser
window was left open from a previous session).

If you cannot reconnect, try the following actions to resolve the problem:

¢ Check current memory availability. This problem can be caused by a
memory failure in the master console, causing it to run with less than
the required one gigabyte of memory. If there is a memory problem, you
need to correct it.

* Determine if the IP address of the master console has changed since the
last reboot. If so, reboot the master console to correct the problem.

Troubleshooting Tivoli SAN Manager problems

This topic describes how to troubleshoot problems with Tivoli SAN Manager.
Problem

Use this information to troubleshoot problems that you are having with Tivoli SAN
Manager.

Investigation
Tivoli SAN Manager loses information.

If Tivoli SAN Manager shows all resources as red (offline or out of contact)
you should ensure that you have the Ethernet connections installed
correctly.

¢ Port 1 should be connected to the (public) network (such as the rest of
your LAN).

e Port 2 should be connected to the (private) device network—that is the
devices connected to the SAN Volume Controller Engines or SAN File
System cluster, the storage controllers and the SAN switches.

Tivoli SAN Manager shows a black (blank) topology.

If Tivoli SAN Manager shows a black (blank) topology:

1. Check that the file in use exists in the c:\Program Files\SQLIB\javal2\
directory. If it does not, shut down Tivoli SAN Manager and run the
jdbc2 batch file.
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2. Edit c:\WINNT\system32\drivers\etc\hosts. If the local host is

defined, verify that it is in the following format:
IP_address fully_qualified_domain_name short_name
If it is not, add another entry for the local host using this format.

Troubleshooting VPN problems

This topic describes how to troubleshoot problems with the virtual private network

(VPN).

Problem

Use this information to troubleshoot problems that you are having with VPN.

Investigation

If you are having trouble establishing the VPN connection
Perform the following steps to resolve the problem:

1.

Attempt to ping 198.74.67.235 from the master console. If you do not
receive a response:

a. Ensure that you have added an additional subnet route.

b. Run netstat -rn and verify that you have lines similar to the
following. Note the items in bold will differ depending on the
Master Console.

Newly added: 198.74.64.0 255.255.252.0 198.74.64.21

198.74.64.21 2
Default: 198.74.64.0 255.255.255.0 198.74.64.21
198.74.64.21 1

View the IP Security Monitor:
a. From a command window on the MC, enter ipsecmon.

b. If there is no information in the Security Associations window, a
VPN connection is not running.

c. Click Options to increase or decrease the refresh value.
Verify that an active tunnel is running. From the Master Console:

a. Make sure that the connection manager has been started and is
properly connected

b. View the IP Security Monitor.
If the Connection Manager is attempting to connect repeatedly:

a. Ensure that the connection is configured properly and that you have
added additional subnet routes.

b. Check the IP Security Monitor to ensure a connection has been
established.

c. Stop and restart the IPSec Service from a command prompt:

net stop policyagent
net start policyagent

Troubleshooting Windows problems

This topic describes how to troubleshoot problems with Windows.
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Problem
Use this information to troubleshoot problems that you are having with Windows.

Investigation
If Windows will not boot

If, during the Windows boot process, Windows tries to start but fails with
a 'blue screen’ with the message “Inaccessible Boot Device” and another
reboot does not solve the problem. This could be due to the windows boot
code being corrupted on the Startup Device.

Perform the following steps to resolve the problem.

Reboot the master console.

When Press F1 for Configuration/Setup is displayed, press F1.

Select Start Options.

Select Start Sequence.

Step down the sequence to the one that contains the Hard Disk.

Using the left/right cursor keys select the other hard disk. (If it is set to
1, select 0. If it is set to 0, select 1)

7. Press Esc to exit until you get the option to Save and exit. The select
Yes.

8. If the master console boots up, proceed with the steps for recovering
from a master console disk failure. Otherwise, contact your support
representative.

I o

Viewing error information on the master console

This topic describes how to view error information on the master console.

All of the SAN Volume Controllers, SAN File System metadata servers,
fibre-channel switches, and storage, for example, DS4000, generate SNMP Traps as
a result of events, such as errors and configuration changes. The errors are usually
sent to IBM Director and are listed in the Director Event Log. You can view all the
events with their time stamps that help you to determine which event is most
likely to cause a problem

Example: The loss of a fibre-channel path/link due to a cable or GBIC fault could
result in a number of different events being logged to the Director Event Log from
the devices at each end of the failing cable, such as a SAN Volume Controller,
fibre-channel switch, or storage.

Some SAN component communication, such as fibre-channel path errors, can also
be seen in the Tivoli SAN Manager topology displays. The link and/or component
are shown in red. If the problem is intermittent , you might see the component
shown in yellow. For example, you might see the component shown in yellow if
there is a loss of the link and now the link is restored.

Loss of just a component (shown in red) without the loss of the fibre-channel path
(still showing in black) to it can indicate an IP connection problem between the
master console and the component. Loss of the IP connection between the master
console and a host can, if that host is the only Host with a Tivoli SAN Manager
Agent installed, that has VDisks assigned from that SAN Volume Controller
cluster, result in one or more SAN Volume Controllers also showing in red.
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If you identify a fibre-channel path/link problem, the failure might be the
fibre-channel cable, GBICs, SAN component, or host adapter at ends of the failing
link.

To resolve the problem, you might need to refer to the service documentation for
the link end device involved (SAN Volume Controller, fibre-channel switch,
DS4000, host)

If you identify a particular SAN Component failure, refer to the service
documentation for that component to resolve the problem. The master console
C:\Documents directory contains copies of the various component documentation.
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Appendix A. Accessibility

This topic provides information about the accessibility features of SAN File System
and its accompanying documentation.

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use software products successfully.

Features

These are the major accessibility features in SAN File System:

* You can use screen-reader software and a digital speech synthesizer to hear what
is displayed on the screen.

Note: The SAN File System Information Center and its related publications are
accessibility-enabled for the IBM Home Page Reader.

* You can operate all features using the keyboard instead of the mouse.
Navigating by keyboard

You can use keys or key combinations to perform operations and initiate many
menu actions that can also be done with a mouse. You can navigate the SAN File
System console and help system from the keyboard by using the following key
combinations:

 To traverse to the next link, button or topic, press Tab inside a frame (page).

* To expand or collapse a tree node, press Right Arrow or Left Arrow, respectively.
* To move to the next topic node, press Down Arrow or Tab.

* To move to the previous topic node, press Up Arrow or Shift+Tab.

* To scroll all the way up or down, press Home or End, respectively.

* To go back, press Alt+Left Arrow

* To go forward, press Alt+Right Arrow.

* To go to the next frame, press Ctrl+Tab. There are quite a number of frames in
the help system.

* To move to the previous frame, press Shift+Ctrl+Tab.
* To print the current page or active frame, press Ctrl+P.
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Appendix B. Getting help, service, and information

If you need help, service, technical assistance, or just want more information about
IBM products, you can find a wide variety of sources available from IBM to assist
you.

Services available and telephone numbers listed are subject to change without
notice.

Software Maintenance Agreement

All distributed software licenses include Software Maintenance
Agreement(software subscription and technical support) for a period of 12 months
from the date of acquisition providing a streamlined way to acquire IBM software
and assure technical support coverage for all licenses. You can elect to extend
coverage for a total of three years from date of acquisition. While your Software
Maintenance is in effect, IBM provides you assistance for your 1) routine, short
duration installation and usage (how-to) questions; and 2) code-related questions.
IBM provides assistance by telephone and, if available, electronic access, only to
your information systems (IS) technical support personnel during the normal
business hours (published prime shift hours) of your IBM Support Center. (This
assistance is not available to your end users.) IBM provides Severity 1 assistance 24
hours a day, every day of the year.

Before you call for service

This topic provides information you need to know before you call for service.

Some problems can be solved without outside assistance. You can use the online
help by looking in the online or printed documentation that comes with the SAN
File System, or by consulting the IBM Support Home Web site. Also, be sure to
read the information in any README files and release notes that come with the
SAN File System.

Getting help online

IBM maintains pages on the World Wide Web where you can get information
about IBM products and services and find the latest technical information.

lists some of these pages.

Table 3. IBM Web sites for help, services, and information

[www.ibm.com/| Main IBM home page

[www.ibm.com/storage /| IBM Storage home page

[www.ibm.com /storage/support| IBM Support home page
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Getting help by telephone

With the original purchase of the SAN File System, you have access to extensive
support coverage. During the product warranty period, you can call the IBM
Support Center (1 800 426-7378 in the U.S.) for product assistance covered under
the terms of the software maintenance contract that comes with SAN File System
purchase.

Have the following information ready when you call:

* SAN File System software identifier, which can be either the product name (SAN
File System) or the Product Identification (PID) number

* Description of the problem
* Exact wording of any error messages

* Hardware and software configuration information
If possible, have access to your master console when you call.

In the U.S. and Canada, these services are available 24 hours a day, 7 days a week.
In the U.K,, these services are available Monday through Friday, from 9:00 a.m. to
6:00 p.m. In all other countries, contact your IBM reseller or IBM marketing
representative.'

1. Response time varies depending on the number and complexity of incoming calls.
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Appendix C. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines
Corporation or Tivoli Systems Inc. in the United States or other countries or both:

DB2 IBM logo xSeries
DB2 Universal Database NetView
Enterprise Storage Server® Tivoli
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eServer TotalStorage
IBM WebSphere

Intel and Pentium are trademarks of Intel Corporation in the United States, other
countries, or both.

Java and all Java-based trademarks are registered trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, and Windows NT® are trademarks or registered trademarks
of Microsoft Corporation.

Red Hat and all Red Hat-based trademarks and logos are trademarks or registered
trademarks of Red Hat, Inc., in the United States and other countries.

UNIX® is a registered trademark of The Open Group in the United States and
other countries.

Other company, product, and service names may be trademarks or service marks
s,
=

of others. ng}p{;\?mu
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